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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
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Postfach 48 48
90026 NÜRNBERG
GERMANY

Document order number: A5E03071515
Ⓟ 07/2022 Subject to change

Copyright © Siemens AG 2022.
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Introduction 1
1.1 Purpose of this documentation

These instructions contain all information required to commission and use the device. Read the 
instructions carefully prior to installation and commissioning. In order to use the device 
correctly, first review its principle of operation.
The instructions are aimed at persons mechanically installing the device, connecting it 
electronically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers.

1.2 Document history
The contents of these instructions are regularly reviewed and corrections are included in 
subsequent editions. We welcome all suggestions for improvement.   
The following table shows the most important changes in the documentation compared to each 
previous edition.

Edition Remarks
04/2022 • Update for software version 3.13/device revision 16
10/2021 •  Correction of torque values
09/2021 • Update for software version 3.12
03/2020 • Corrections regarding pulse B output
02/2020 • Update for software version 3.11/device revision 15
07/2019 • MAG 8000 Irrigation discontinued and removed
11/2018 • Update for software version 3.09

• Technical data and Appendix C.2 updated
05/2014 • NMI M 10 approval for MAG 8000 Irrigation
10/2012 • Primary operation software changed from Flow Tool to PDM (Flow Tool moved to 

appendix)
• Qualification Certificate functionality added

03/2010 • Integration of MAG 8000 for irrigation applications
• Restructuring of the document

1.3 Checking the consignment
1. Check the packaging and the delivered items for visible damages.
2. Report any claims for damages immediately to the shipping company.

SITRANS FM MAG 8000 Battery-operated water meter
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3. Retain damaged parts for clarification.
4. Check the scope of delivery by comparing your order to the shipping documents for 

correctness and completeness.  
WARNING

Using a damaged or incomplete device
Risk of explosion in hazardous areas.
• Do not use damaged or incomplete devices.

1.4 Items supplied
• SITRANS F M MAG 8000 Standard, MAG 

8000 CT
• Siemens Process Instrumentation docu‐

mentation disk containing certificates, and 
manuals

 

Note
Scope of delivery may vary, depending on version and add-ons. Make sure the scope of delivery 
and the information on the nameplate correspond to your order and the delivery note.

1.5 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected to 
an enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.

Introduction
1.5 Security information
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For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under 
https://www.siemens.com/cert. 

1.6 Transportation and storage
To guarantee sufficient protection during transport and storage, observe the following:
• Keep the original packaging for subsequent transportation.
• Devices/replacement parts should be returned in their original packaging.
• If the original packaging is no longer available, ensure that all shipments are properly 

packaged to provide sufficient protection during transport. Siemens cannot assume liability 
for any costs associated with transportation damages.
NOTICE
Insufficient protection during storage
The packaging only provides limited protection against moisture and infiltration.
• Provide additional packaging as necessary.

Special conditions for storage and transportation of the device are listed in Technical 
specifications (Page 93).

1.7 Notes on warranty
The contents of this manual shall not become part of or modify any prior or existing agreement, 
commitment or legal relationship. The sales contract contains all obligations on the part of 
Siemens as well as the complete and solely applicable warranty conditions. Any statements 
regarding device versions described in the manual do not create new warranties or modify the 
existing warranty.
The content reflects the technical status at the time of publishing. Siemens reserves the right to 
make technical changes in the course of further development.

Introduction
1.7 Notes on warranty
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Safety notes 2
2.1 General safety instructions

CAUTION
Correct, reliable operation of the product requires proper transport, storage, positioning 
and assembly as well as careful operation and maintenance.
Only qualified personnel should install or operate this instrument.  

Note
Alterations to the product, including opening or improper modifications of the product are not 
permitted.
If this requirement is not observed, the CE mark and the manufacturer's warranty will expire.

2.2 Laws and directives
Observe the safety rules, provisions and laws applicable in your country during connection, 
assembly and operation. These include, for example:     
• National Electrical Code (NEC - NFPA 70) (USA)
• Canadian Electrical Code (CEC Part I) (Canada)
Further provisions for hazardous area applications are for example:   
• IEC 60079-14 (international)
• EN 60079-14 (EU and UK)

2.3 Conformity with European directives
The CE marking on the device symbolizes the conformity with the following European directives:

Electromagnetic compatibili‐
ty EMC 
2014/30/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to elec‐
tromagnetic compatibility

Low voltage directive LVD 
2014/35/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to the 
making available on the market of electrical equipment designed 
for use within certain voltage limits

Pressure equipment direc‐
tive PED 
2014/68/EU

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to the 
making available on the market of pressure equipment

SITRANS FM MAG 8000 Battery-operated water meter
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RED 
2014/53/EU

Directive of the European Parliament and of the Council  on the 
harmonisation of the laws of the Member States relating to the 
making available on the market of radio equipment and repeal‐
ing Directive 1999/5/EC

Measuring instruments di‐
rective MID 
2014/32/EU

Directive of the European Parliament and the Council on the har‐
monisation of the laws of the Member States relating to the mak‐
ing available on the market of measuring instruments

2011/65/EU RoHS Directive of the European Parliament and the Council on the re‐
striction of the use of certain hazardous substances in electrical 
and electronic equipment

The applicable directives can be found in the EU declaration of conformity of the specific device.

2.4 Lithium batteries
Lithium batteries are primary power sources with high energy content designed to provide the 
highest possible degree of safety.  

WARNING
Potential hazard
Lithium batteries may present a potential hazard if they are abused electrically or mechanically. 
Observe the following precautions when handling and using lithium batteries:
• Do not short-circuit, recharge or connect with false polarity.
• Do not expose to temperatures beyond the specified temperature range.
• Do not incinerate.
• Do not crush, puncture or open cells or disassemble.
• Do not weld or solder to the battery’s body.
• Do not expose contents to water.

This device is not approved for use in hazardous areas.

Safety notes
2.4 Lithium batteries
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Description 3
3.1 System components

A SITRANS F M MAG 8000 water meter system includes:   
• A transmitter and a sensor. The transmitter is either compact mounted (integral) or remote 

mounted at a distance of maximum 30 m (100 ft).
• An internally or externally mounted battery supply or 115 to 230 V AC or 12/24 V AC/DC 

power supply with battery backup.

Communication solutions
The following communication modules are available:
• RS 232/RS 485 Modbus RTU
• Encoder interface for AMR solutions
• 3G/UMTS module
• 4G/LTE module

3.2 Operating principle
MAG 8000 is a microprocessor-based water meter with graphical display and key for optimum 
customer operation and information on site. The transmitter drives the magnetic field in the 
sensor, evaluates the flow signal from the sensor, and calculates the volume passing through. 
Its intelligent functionality, information and diagnostics ensure optimum meter performance 
and information to optimize water supply and billing.
MAG 8000 Standard and MAG 8000 CT can be ordered as a Basic or an Advanced version.

3.3 Design
MAG 8000 is a battery-supplied magnetic inductive water meter for revenue, district metering 
application.

Figure 3-1 MAG 8000 product program

SITRANS FM MAG 8000 Battery-operated water meter
Operating Instructions, 08/2022, A5E03071515-AL 13



Compact

Figure 3-2 MAG 8000 Standard compact

Remote

Figure 3-3 MAG 8000 Standard remote

Custody transfer
Compact and remote versions.

Figure 3-4 MAG 8000 CT (compact version)

Description
3.3 Design
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① Product name ⑪ Manufacturer and place of manufacture
② Article number and serial number ⑫ Maximum allowable working pressures
③ Size and liner type ⑬ Process media temperature
④ Sensor material ⑭ Process connection
⑤ Permitted meter orientation ⑮ Manufacturing year
⑥ Degree of protection ⑯ Permitted ambient temperature
⑦ Calibration factor and fluid group ⑰ Dynamic range
⑧ Power supply ⑱ Software version and hardware version
⑨ Certification number ⑲ Maximum flow rate
⑩ Sensitivity class ⑳ Conformity with country-specific directives

Figure 3-5 MAG 8000 CT nameplate example  

3.4 Benefits
• Simple placement of the meter - bury the meter underground or in a floating chamber. The 

IP 68 (NEMA 6P) design is unaffected by meter position or in-line piping stresses, and there 
is no requirement for filters.

• Minimal pressure loss - an unrestricted flow tube ensures minimal pressure loss, even at the 
highest flow rates. Overall network system pressures can be reduced, helping to prevent 
leakage from burst pipes ánd excess stress placed on pumping stations. This also saves 
energy.

• Zero maintenance - designed without moving parts and a battery lifetime of up to 15 years.
• Measurement in both directions - only one meter required for measuring in both direction.
• Intelligent meter - only one meter for leak detection, data logger function, and self-detection 

of errors.

Description
3.4 Benefits

SITRANS FM MAG 8000 Battery-operated water meter
Operating Instructions, 08/2022, A5E03071515-AL 15



Description
3.4 Benefits

SITRANS FM MAG 8000 Battery-operated water meter
16 Operating Instructions, 08/2022, A5E03071515-AL



Installing/Mounting 4
MAG 8000 water meters are suitable for indoor and outdoor installations.
• Make sure that pressure and temperature specifications indicated on the device nameplate / 

label are not exceeded.      

General information
This chapter describes how to install the water meter in the compact version as well as in the 
remote version.

8
7

L
1

3
0

.1
0

Figure 4-1 Compact installation   

Figure 4-2 Remote installation  
The installation consists of two steps:
1. Sensor installation.
2. Transmitter installation (remote version only).

SITRANS FM MAG 8000 Battery-operated water meter
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4.1 Sensor installation
The sensor installation consists of three steps:
1. Locating the sensor (Page 18).
2. Orienting the sensor (Page 20).
3. Mounting the sensor (Page 22).

4.1.1 Locating the sensor
Ensure that the sensor is located in the most optimum place and no magnetic fields are present.

8
7

L
1

6
6

N S

Flow direction
Ensure that sensor is mounted in correct flow direction as indicated on label.

If process flow direction is opposite of flow direction indicated on sensor label, forward flow 
rates can be restored via parameter 327, if factor is adjusted to "-1".
MAG 8000 CT is approved for bidirectional measurement for class 2 OIML R49.

Inlet and outlet condition
To achieve most accurate flow measurement it is essential to have certain straight inlet and 
outlet pipe lengths as shown (Di: sensor diameter). 

Installing/Mounting
4.1 Sensor installation
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MAG 8000 CT is approved with OIML R49:2013 and MID for the following installations:
• DN 50 to DN 300 with 0x Di of straight pipe upstream to the sensor and 0x Di of straight pipe 

downstream from the sensor.
• DN 350 to DN 600 with 3x Di of straight pipe upstream to the sensor and 3x Di of straight pipe 

downstream from the sensor.
For optimal measurement performance, it is recommended to follow the installation guidelines 
for the MAG 8000 standard water meter.

  MAG 8000
(recommended)

MAG 8000 CT
DN 50 to DN 300

MAG 8000 CT
DN 350 to DN 600

① Minimum straight inlet pipe length 5x Di 0x Di 3x Di

② Minimum straight outlet pipe length 3x Di 0x Di 3x Di

Sensor must be completely full of liquid

Installing/Mounting
4.1 Sensor installation
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Therefore avoid:
• Air in pipe.
• Installation at the highest point in pipe system.
• Installation in vertical pipes with free outlet.

Partially filled pipes
For partially filled pipes or pipes with downwards flow and free outlet, sensor must be mounted 
in a U-tube.

4.1.2 Orienting the sensor
MAG 8000 CT with OIML R49:2013 and MID approval DN 50 to DN 600 can only be installed 
horizontally.

Horizontal pipes

Installing/Mounting
4.1 Sensor installation
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Sensor must be mounted as shown in upper part of figure. Do not mount sensor as shown in 
lower part of figure as electrodes then will be positioned at top where air bubbles may occur and 
in bottom, where mud, sludge, sand etc. may deposit and cover the electrode, thus impacting 
the measurement.
If "Empty Pipe Detection" is used, sensor should be tilted 45° as shown in upper right figure to 
maximize full pipe detection and provide accurate volume calculations.

Note
Physical installation of battery pack may influence battery capacity. Optimal battery capacity is 
achieved with battery pack in an upright position. Installation examples marked with dotted 
cross will affect battery capacity.

Vertical pipes (MAG 8000)
Recommended installation is in a vertical/inclined pipe to minimize wear and deposits in sensor.

Installation in large pipes (MAG 8000)
The water meter can be installed between two reducers (e.g. DIN 28545).

With an 8° reducer, the following pressure drop curve applies. The curves are applicable to water.

Installing/Mounting
4.1 Sensor installation
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Example:
A flow velocity of 3 m/s (10 ft./sec.) (V) in a sensor with a diameter reduction from DN 100 to DN 
80 (4" to 3") (d1/d2 = 0.8) gives a pressure drop of 2.9 mbar (0.04 psi).

4.1.3 Mounting the sensor
1. Install gaskets.
2. Ensure connection flange has a smooth surface and is in line with sensor.

Gaskets are recommended but not included in water meter delivery.

Installing/Mounting
4.1 Sensor installation
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Advice for gasket selection:
• Only use flat rubber gaskets.
• Thickness 1 to 6 mm (0.0 to 0.02 ft) dependent on gap/tolerance.
• Inner diameter must be larger than bore of water meter.
• Material should be compatible with process fluid.
• Hardness should be maximum 75 Shore A.

Transporting

WARNING
Lifting the sensor
Do NOT lift the sensor by the terminal box. Do NOT use a forklift. If available lift the sensor by 
the lifting eyes fitted to the device. Otherwise lift the sensor by the process connections.

Figure 4-3 Incorrect transportation

Figure 4-4 Correct transportation

Installing/Mounting
4.1 Sensor installation
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Vibrations   
In installations with strong vibrations remote installation of the transmitter is recommended. 
Alternatively mitigate vibrations by installing pipe support in close proximity to the water meter.

Figure 4-5 Vibration mitigation

Maximum allowable torques
Standard bolts must be well lubricated and tightened evenly around gasket.

Leakage/damage to water meter or piping may arise if bolts are overtightened.
Torque calculations
All values are theoretical and are calculated on the assumption that:
• All bolts are new and material selection is according to EN 1515-1 table 2.
• Gasket material not exceeding 75 shore A is used between the water meter and mating 

flanges.
• All bolts are galvanized and adequately lubricated.
• Flanges are made of carbon steel.
• Water meter and mating flanges are correctly aligned.

Table 4-1 Minimum and maximum torques for 7ME6810 and 7ME6820, EN 1092-1 in Nm
Nominal 
size

EN 1092-1
PN 10 PN 16 PN 25 PN 40

Liner EPDM EPDM EPDM EPDM
mm inch Min. Max. Min. Max. Min. Max. Min. Max.
25 1 - - - - - - 6.9 7
40 1 ½ - - - - - - 15.0 16
50 2 - - 9.2 10 - - - -

Installing/Mounting
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Nominal 
size

EN 1092-1
PN 10 PN 16 PN 25 PN 40

Liner EPDM EPDM EPDM EPDM
mm inch Min. Max. Min. Max. Min. Max. Min. Max.
65 2 ½ - - 6.7 7 - - - -
80 3 - - 8.2 9 - - - -
100 4 - - 11.6 12 - - - -
125 5 - - 16.4 17 - - - -
150 6 - - 26.8 28 - - - -
200 8 26.1 27 27.9 29 - - - -
250 10 25.5 27 48.8 51 - - - -
300 12 34.0 36 65.1 68 - - - -
350 14 33.7 35 67.0 70 138.6 146 257.4 270
400 16 50.7 53 94.3 99 189.9 199 373.4 392
450 18 49.4 52 95.1 100 183.5 193 327.5 344
500 20 59.8 63 130.6 137 225.4 237 426.1 447
600 24 92.3 97 200.6 211 338.6 356 702.2 737
700 28 104.9 110 201.0 211 - - - -
750 30 - - - - - - - -
800 32 149.8 157 282.3 296 - - - -
900 36 158.4 166 298.8 314 - - - -
1000 40 210.1 221 400.6 421 - - - -
1050 42 - - - - - - - -
1100 44 - - - - - - - -
1200 48 289.1 304 575.4 604 - - - -

Table 4-2 Minimum and maximum torques for 7ME6810 and 7ME6820, ANSI B16.5, AWWA C-207 and AS 4087 in Nm
Nominal 
size

ANSI B16.5 AWWA C-207 AS 4087
Class 150 Class D PN 16

Liner EPDM EPDM EPDM
mm inch Min. Max. Min. Max. Min. Max.
25 1 7.8 8 - - - -
40 1 ½ 12.9 14 - - - -
50 2 11.9 13 - - 7.5 8
65 2 ½ 17.2 18 - - 13.3 14
80 3 21.2 22 - - 16.4 17
100 4 15.0 16 - - 23.2 24
125 5 25.0 26 - - - -
150 6 32.8 34 - - 21.6 23
200 8 51.1 54 - - 33.6 35
250 10 56.0 59 - - 61.2 64
300 12 74.7 78 - - 54.4 57

Installing/Mounting
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Nominal 
size

ANSI B16.5 AWWA C-207 AS 4087
Class 150 Class D PN 16

Liner EPDM EPDM EPDM
mm inch Min. Max. Min. Max. Min. Max.
350 14 103.7 109 - - 89.3 94
400 16 100.8 106 - - 111.4 117
450 18 145.9 153 - - 141.9 149
500 20 140.1 147 - - 129.6 136
600 24 216.4 227 - - 203.9 214
700 28 - - 116.9 123 206.0 216
750 30 - - 131.7 138 - -
800 32 - - 178.3 187 338.8 356
900 36 - - 194.1 204 350.8 368
1000 40 - - 212.3 223 408.5 429
1050 42 - - 233.7 245 - -
1100 44 - - 230.7 242 - -
1200 48 - - 246.8 259 446.7 469

4.2 Potential equalization
Liquid potential equalization or grounding is accomplished with built-in grounding electrodes 
and/or grounding rings. The electrodes ensure electrical connection between liquid and meter 
providing a stable and accurate measurement.

① Built-in grounding electrode
(7ME6810 and 7ME6820)
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4.3 Grounding
The sensor body must be grounded using grounding/bonding straps and/or grounding rings to 
protect flow signal against stray electrical noise and/or lightning. This ensures that noise is 
carried through sensor body and that the measuring area within sensor body is noise-free.

Note
Grounding connector rotated by 90°
For sensor sizes between DN 25 (1") and DN 300 (12"), the grounding connector on the sensor 
is rotated by 90°.

Metal pipes
Connect straps to both flanges with 6 mm (1/4") screws.

① Metal pipes
② Grounding straps (rotated by 90° on DN 350 to DN 1200)

Grounding straps are part of delivery and pre-mounted on water meter.
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Plastic pipes and lined metal pipes
Use optional grounding rings at both ends.

① Plastic pipes or lined metal pipes

Grounding rings are not included in delivery.

Combination of metal and plastic pipes
Use straps for metal pipe and grounding rings for plastic pipe.

① Metal pipe
② Plastic pipe

Bonding/grounding straps, grounding rings and straps are not included in delivery.

Note
All straps or grounding wires must be 12 AWG (or heavier) copper wire and connected with 6 
mm screws.
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4.4 Cathodic-protected pipes
Pay special attention to meter installation in cathodic-protected pipe.

Isolate meter from pipeline by mounting isolation sleeves and washers on flange bolts and 
connect a wire dimensioned to manage the cathodic current and environmental influence, 
between pipelines.

4.5 Potting and direct burial

NOTICE
Electrical connections
Do not pot meter before electrical connections have been made.

Meter is rated IP68/NEMA 6P from the factory as standard. If cable glands are used, IP68/NEMA 
6P enclosure rating is obtained by potting transmitter bottom with Sylgard potting kit. 
Otherwise only an IP67/NEMA 4 rating is obtained.

Sealing of transmitter
1. Select the proper gland size to fit installed cable size.
2. Mount O-ring properly and correctly and grease with gel.

Installing/Mounting
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3. Fill Sylgard potting kit in bottom part of casing.
4. Renew Silicagel bag (placed behind battery cup) to prevent condensation within meter, if 

necessary.
5. Mount the enclosure carefully and make sure not to damage the O-ring.

Note
Potting
Ensure not to fill the potting kit in the space for the battery pack.
Ensure Silicagel bag is not in contact with the potting compound.

See also Potting kit instruction (http://support.automation.siemens.com/WW/view/en/
43208835).

Direct burial of remote sensor

Remote sensor is protected to IP68/NEMA 6P and can be buried.
The use of pea gravel, at least 300 mm (12 inches) all around sensor, is mandatory to provide 
some drainage and to prevent dirt from solidifying on sensor.
It also helps to locate the sensor should excavation be necessary. Before covering pea gravel with 
earth, use electrical cable identification tape above gravel.
Run remote sensor cable through a plastic conduit of minimum 50 mm (2 inches).

4.6 Transmitter installation
Mount bracket on a wall as shown below or on a horizontal or a vertical pipe using ordinary hose 
clips or duct straps.
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Wall mounting

Figure 4-6 Wall mounting

Pipe mounting

Figure 4-7 Pipe mounting - vertical

Figure 4-8 Pipe mounting - horizontal

4.7 MAG 8000 CT
Calibration sealing has been carried out at calibration.
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4.7.1 Sealing of MAG 8000 CT

4.7.1.1 Verification sealing

Note
The verification sealing is done at factory after initial verification.

Note
For type-approved and verified MID MAG 8000 CT products
The verification sealing may only be broken by an authorized person, with the acceptance and 
under direction of the local authorities.

Figure 4-9 MAG 8000 CT verification sealing (A)

4.7.1.2 User sealing

Note
User sealing has to be done after commissioning by an authorized person.

1. Lead one or two wires through the sealing bolts.
2. Seal the ends of each wire.
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MAG 8000 CT user sealing (A) - compact MAG 8000 CT user sealing - remote

4.7.2 Installation conditions

4.7.2.1 MID option (MI-001)
MAG 8000 CT are approved for MI-001 under the following installation conditions.
• DN 50 to 300 (2" to 12") in all orientations
• DN 350 to 600 (14" to 24") only in horizontal installation

Note
Straight pipe upstream and downstream
• DN 50 to DN 300 requires 0x D of straight pipe upstream and downstream from the sensor.
• DN 350 to DN 600 requires 3x D of straight pipe upstream and 3x D downstream from the 

sensor

Other restrictions may apply (see certificate).
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Connecting 5
This chapter consists of general safety requirements as well as a description of how to connect 
the device.
The connection of the device is done in four steps.
1. Wiring sensor and transmitter (remote version only) (Page 37).
2. Connecting power supply (Page 38).
3. Connecting outputs (Page 40).
4. Connecting add-on module (Page 44).

Connection diagram

① Module Interface (Option)
② Output A
③ Output B

The 3.6 V DC battery connector - plug and pulse connection terminals are placed in the left side 
of the PCB board - see figure.
Connection for add-on interface modules is placed on the left side.
HL = Hardware lock key connection
V = Verification button (enables verification mode for 4 hours)
To configure the outputs via PDM, see "Output configuration" (Page 58).
To configure the outputs via Flow Tool, see "Output configuration" (Page 131) in the Flow Tool 
appendix.
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5.1 General safety requirements

WARNING
The pertinent regulations must be observed for electrical installation.
• Never install the device with the mains voltage switched on!  
• Danger of electric shock!
• The electrodes and magnetic current line may only be connected when the device is not 

connected to the power supply.
• If the housing is under voltage (power supply), the cover may be unscrewed by qualified 

personnel only.

WARNING
Mains supply from building installation Class II  
A switch or circuit breaker (max. 16 A) must be installed in close proximity to the equipment 
and within easy reach of the operator. It must be marked as the disconnecting device for the 
equipment.
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5.2 Remote version

Remote installation

MAG 8000 CT user sealing

1. Verify that model and serial numbers shown on labels of sensor and transmitter are matched 
properly.

2. Ensure that cable is safely installed to avoid damage of cable and connectors. Please note the 
different coil and electrode connector types both having a minimum RADIUS of 45 mm (1.8 
inches); otherwise there s a risk of damaging the cable. Save dust covers for future use and 
protection.

3. Ensure connectors are clean.
4. Ensure connectors are fastened securely to achieve a good connection and watertight seal.

Note
If dirt enters connector ends, use plain water for cleaning. Ensure connectors are completely 
dry before making connections.

For MAG 8000 CT user sealing, see Sealing of MAG 8000 CT (Page 32).
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5.3 Power supply

Connection diagram for 115 to 230 V AC (mains) or 12/24 V AC/DC (line) power supply

7

8
7

L
1

1
2

.1
2

.1
0

Backup battery connection ① Red
② Black

MAG 8000 PCB connection ③ Blue
④ Yellow

External power supply con‐
nection

⑤ Blue (Neutral / -)
⑥ Brown (Line / +)

Shielding ⑦ Shielding wire
It is mandatory to connect the shielding wire to the MAG 8000 device earthing; otherwise IrDA 
communication will not work satisfactorily.

115 to 230 V AC (mains) power supply
Mains power input Factory mounted PUR cable with 2 x 1 mm2 (brown wire, blue wire) cable length = 3 m

Brown wire - L (Line, +) and blue wire - N (Neutral, -)
Mains power output Battery cable socket with blue and yellow wires; blue wire is ground. Battery cable socket has to 

be connected to 3.6 V DC cable plug on PCB board
Battery backup input Battery cable plug with black and red wires; black wire is ground. Battery cable plug has to be 

connected to cable socket on backup battery
Functional ground Black wire with terminal must be connected to the device encapsulation with a screw
Mains power supply has to be connected to a switch near water meter according to IEC 61010-1 clause 5.4.3.d

12/24 V AC/DC (line) power supply
Line power input Factory mounted PUR cable with 2 x 1 mm2 (brown wire, blue wire) cable length = 3 m

Brown wire - L (line, hot, positive) and blue wire - N (neutral, cold, negative)
Line power output Battery cable socket with blue and yellow wires; blue wire is ground. Battery cable socket has to 

be connected to 3.6 V DC cable plug on PCB board
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Battery backup input Battery cable plug with black and red wires; black wire is ground. Battery cable plug has to be 
connected to cable socket on backup battery

Functional ground Black wire with terminal must be connected to the device encapsulation with a screw

Cable installation

Choose the correct glands for the selected cable type, see Accessories for glands selection. 
Ensure shield is mounted under cable clamps - do not make pig tails.

Note
Mains or line-powered PUR cable (no shield) has to be mounted under cable clamps. All cable 
glands have to be sufficiently tightened to ensure IP-rating. 
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5.4 Outputs

Pulse output connection diagram for MAG 8000
MAG 8000 internal connection
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②
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Output A
Output B
Passive output - no polarization - open drain

External connection variant
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④
⑤
⑥

 
 
 
 
Positive pulse logic
Negative pulse logic
Signal

Pulse output can be configured as volume, alarm or call-up, see Commissioning (Page 58).
Pulse output is not polarized and can be connected for positive or negative logic.
Pull up/down resistor (R) is selected in relation to power supply voltage (V) and with a max. 
current (I) of 50 mA.

Note
Pulse output isolation
The MAG 8000 pulse output has a functional isolation only and must therefore be connected to 
equipment complying with the Low Voltage Directive in order to be considered safe.
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Note
Pulse output is not part of the MID-001 approval
The use of the pulse output for billing purposes is only permitted if:
• The legislation in the country of use permits an ancillary device for verification required 

billing. The regulations are not uniform within the European Union. In some countries, the 
local display of the water meter is the only permitted display for use in legal metrology. 

• The system consisting of the MAG 8000 CT pulse output and the pulse count of an external 
measured-value display is certified by the national metrological authority.

• Pulse B function is only allowed to be set to Alarm or call up in MAG 8000 CT with MID-001 
approval.

5.5 Communication modules

RS 232 connection diagram

① Common
② Connect shield to encapsulation
③ Shield must be connected to protective ground

① Common

A Modbus over serial line cable must be shielded.
At one end of each cable its shield must be connected to protective ground. If a connector is used 
at this end, connector shell must be connected to cable shield.
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RS 485 connection diagram

① Common
② Connect shield to encapsulation
③ Shield must be connected to protective ground

① Common
② Termination

A Modbus RS 485 must use a balanced pair (for D+ - D−) and a third wire (for common).
For the balanced pair used in an RS 485 system, a characteristic impedance with a value between 
100 and 120 ohms must be used.
Shield must always be connected to MAG 8000 encapsulation using cable clamp as shown in 
figure in section cable installation, see Power supply (Page 38).
Bus termination:
All RS 485-based networks must be terminated correctly to function properly. A termination 
must be placed at each end of segment.
The Modbus RTU module can add a 120 ohm termination if a jumper is placed beside terminals 
in position "ON".
Termination is set to "ON" from factory.
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Encoder interface connection diagram

① Black wire
② Red wire
③ Unshielded wire
④ Endpoint

Figure 5-1 Encoder interface cable connection between MAG 8000 and ITRON 200WP with Itron cable
Connect black wire to terminal 91, red wire to terminal 92 and unshielded wire to terminal 93.

WARNING
Unshielded wire
It is important that unshielded wire does not touch any metal parts of MAG 8000 housing.

Other radio interface cable has to be a 3-wire cable with a shield connected to MAG 8000 
housing (mounting cable shield is shown to the right).

GND

Data

129.10.10

① Power clock
② Connect shield to encapsulation
③ Radio interface

1
2

8
.1

0
.1

0
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5.6 Connection of add-on modules
When the add-on module has been installed, the electrical connections are available on terminal 
rows 91-97.  

For more information
Refer to the relevant BUS communication Quick Start or Operating Instructions available on an 
included DVD or on the internet, at: www.siemens.com/flowdocumentation 
(www.siemens.com/flowdocumentation).

Information on the operation of communication modules
For information on how to operate the various communication modules, see:
• 3G/UMTS add-on module Operating Instructions (https://

support.industry.siemens.com/cs/ww/en/view/109751612)
• Modbus RTU Operating Instructions (http://support.automation.siemens.com/WW/view/en/

54091509)
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Commissioning 6
The meter can be configured using a PC software package - either SIMATIC PDM or Flow Tool.
Both SIMATIC PDM and Flow Tool are software packages for configuring, parameterizing, 
commissioning and maintaining devices (e.g. transducers) and for configuring networks and 
PCs.        
For commissioning via Flow Tool, refer to the appendix "Flow Tool" (Page 121).

6.1 Overview SIMATIC PDM
SIMATIC PDM (Process Device Manager) is a general-purpose, manufacturer-independent tool 
for the configuration, parameter assignment, commissioning, diagnostics and maintenance of 
intelligent field devices and field components. Follow-up installations and additional 
information on SIMATIC PDM are available on the Internet at SIMATIC PDM (https://
www.siemens.com/simatic-pdm).
SIMATIC PDM monitors the process values, alarms and status signals of the device. It allows you 
to display, compare, adjust, verify, and simulate process device data; also to set schedules for 
calibration and maintenance.
For information on, for example, how to install and integrate devices, commission the software, 
see Operating Manual 'Help for SIMATIC PDM'. The manual is delivered with SIMATIC PDM 
software. Once the SIMATIC PDM is installed on your computer you find the manual under: Start 
> All programs > Siemens Automation > SIMATIC > Documentation. Link at our website: 
SIMATIC PDM instructions and manuals (https://support.industry.siemens.com/cs/ww/en/ps/
16983/man).

Note
Field device parameters
• For a list of parameters and additional information, consult section "Parameter lists 

(Page 145)".
• The field device remains in measurement mode during the time you configure the field 

device.
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6.2 Initial commissioning via SIMATIC PDM

6.2.1 Check SIMATIC PDM version

Procedure
1. Go to SIMATIC PDM Download (http://www.siemens.com/simaticpdm/downloads).
2. Check the support page to make sure you have:

– The latest version of SIMATIC PDM
– The most recent Service Pack (SP)
– The most recent hot fix (HF)

6.2.2 Updating the Electronic Device Description (EDD) or Field Device Integration 
(FDI)

Procedure
1. Check that the EDD or FDI revision match the Firmware revision in the device according to the 

table in section Document history (Page 7).
2. Go to the support page Software downloads (https://www.siemens.com/

processinstrumentation/downloads).
3. Enter the product name in the field "Enter search term...".
4. Download the most current EDD or FDI of your device.
5. Save files to your computer in an easily accessed location.
6. Launch SIMATIC PDM – Device Integration Manager.

From the File menu, click "Read device descriptions from compressed source...".
7. Browse to the compressed EDD or FDI files, select and open it. 
8. Use the "Integration" function to integrate the EDD or FDI into the device catalog. The EDD or 

FDI is now accessible via SIMATIC Manager.
This chapter describes how to install the PDM device driver (EDD). The newest EDD driver is 
available on the internet (http://support.automation.siemens.com/WW/view/en/
19701862/133100).
The PDM device driver (EDD) is compatible with PDM 6, PDM 8 and PDM 9.
Install the EDD files from SIMATIC PDM "Manage Device Catalog" via the following steps:
Windows START menu → program folder "SIMATIC" → SIMATIC PDM → Manage device catalog.
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In the SIMATIC PDM "Manage Device Catalog" window, click on "Browse" and navigate to the 
driver and the path where the file was downloaded and saved. The PDM will show a tree with the 
Software options. Click on the "Siemens" checkbox to select all options.
Click OK to install the new EDD files.
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6.2.3 Configuring the device
This chapter describes how to set up the meter for communication with the PC. The options in 
both SIMATIC PDM and Flow Tool software are the same; only the views on the PC screen differ.

Setting up meter
1. Click on "File".
2. Select "New".
3. Assign a new project name in the "Name" box, e.g. MAG8000.

4. In Process Device Network View, right-click on "Net" → select "Insert New Object" → "MODBUS 
net".
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5. Right-click on "MODBUS net" → select "Object Properties...".
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6. Click on "Connection" tab and select "activated" for IrDA. Click "OK".

Note
Maximum data transmission rate
The maximum data transmitter rate for the MAG 8000 is 19 200 baud.
If the IrDA adapter is connected properly, a small IrDA icon will appear in the Windows 
notification area.

When placing mouse at this icon, the device information will be shown (e.g. "MAG8000 
SN1234 is in range").
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7. In Process Device Network View, right-click on "MODBUS net" → "Insert New Object" → 
"MODBUS device".

8. Click on "Assign". In new pop-up window, click on "Flow" → "Electromagnetic" → "Siemens 
AG" → "MAG8000".

9. Select the proper device (MAG 8000 Advanced, MAG 8000 Basic, MAG 8000 CT Advanced, 
or MAG 8000 CT Basic) depending on transmitter version to be controlled.
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10.Click on "OK".

11.Double-click created device, e.g. "MAG8000 Advanced". A new window will pop up for device 
parameter configuration.
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6.3 Setting the basic parameters
Note
No factory reset
The device is delivered with factory settings that are not stored as default values. Because no 
default values are present in the meter, an automatic return to factory values is not possible. 

Enter password
The "User" dialog box is always displayed on the first start-up after installation of SIMATIC PDM 
but not on the first start-up for a specific device. 
You can also use the menu command "Options" → "Settings" to specify whether you are 
permanently registered as a "Maintenance engineer" or "Specialist" and/or whether to disable 
the display of the "User" dialog box. Refer to SIMATIC PDM help manual for more details of 
"Maintenance engineer" and "Specialist".
Proceed as follows:
Click the appropriate button ("Maintenance engineer" or "Specialist").
If the option "Specialist" is selected, enter the password in the "Password" box in order to work 
with additional parameters. The default password is "1000", and can be changed after gaining 
access to the meter.
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Read, write, print or export meter data
Select "Device" → "Upload to PC/PG" to load all device parameters from the device to the offline 
data storage.

Only parameters (data) shown on white background can be changed. Red texts are off-line data 
which are not stored in the MAG 8000 yet, whereas black texts show the actual meter data. Each 
adjustable parameter has a "Default Value", a "Minimum Value", and a "Maximum Value" which 
are prompted by right-clicking on the parameter. More information will be available when the 
"Help" button is clicked.
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Each parameter has a description (prompt) advising how the parameter can be programmed and 
which settings are programmable.
The figure below shows alarm status with the marked alarms enabled. Click on "Transfer" to 
instantly synchronize alarm configurations between the PC and the device.

Figure 6-1 Alarm status - marked alarms are enabled
Select "Device" → "Download to Device…" to download all the changed parameters to the device.
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The meter configuration and parameters can also be exported as PDM data, and imported to 
another location, e.g. another project or PC.
In the SIMATIC Manager view, right-click on the PDM object to be exported, select "Export…". In 
the subsequent dialog box, specify the type of export as well as the name and location where the 
PDM file containing the exported data is to be saved. Confirm the entries by clicking "OK".
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During the export process, a dialog box is displayed showing export progress. After the export 
is completed, the status "Result" is displayed.

See also
www.siemens.com/flow (www.siemens.com/flow)

Commissioning
6.3 Setting the basic parameters

SITRANS FM MAG 8000 Battery-operated water meter
Operating Instructions, 08/2022, A5E03071515-AL 57

http://www.siemens.com/flow


6.4 Unit selection
The device is delivered with totalizer and flow rate units in m and m3/h, respectively, as standard. 
However, it is possible to manually configure the device to operate with other units.

Changing the units
1. Select "Device" → "Unit guide".
2. Select the new unit from the list.
3. Click on "Apply Change of Units".

Afterwards, the change must be stored into the transmitter via "Download to Device".

6.5 Output configuration
Pulse output can be configured as volume pulse, alarm or call-up. Default factory setting is with 
output A enabled for forward flow and output B for alarm output.

Output configuration in SIMATIC PDM
Select "Output". The software window shows the parameters for output configuration. Each 
parameter has its own guideline for selecting the correct parameter setting.
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See "Output characteristics" (Page 99) for more information on how the outputs work.

6.6 Data protection

Using the hardware key

A hardware key is installed in the hardware lock hole to change protected parameters. The 
hardware lock hole is located in the front of the PCB board behind the battery. For a complete list 
of protected parameters go to Unit selection (Page 128).
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Operating 7
7.1 Operation via key and display

The meter is designed with a single key and a symbolic display for optimal dialog.

Display
Display is divided into 3 areas.

Figure 7-1 Display
• Top area with symbols for status information.
• Middle area with actual information.
• Bottom area with index for actual information and selected menu.
Some of the information has additional information connected and display will automatically 
toggle between information, see menu overview (Page 66). If key is not pressed for 10 
minutes, display will time-out and return to default configured operator menu.

Key
There are three different ways the interface key will respond to being pressed:
1. A brief press (less than 2 seconds) will advance screen to next index or menu.
2. A short press (2 to 5 seconds) will enter a menu or escape menu selection.
3. A long press (more than 5 seconds) while in the operator menu ( ) will activate a reset of 

selected value (e.g., call-up function) indicated by an "r".
A flashing "r" indicates a reset. A request for time and date setup is shown during power-up.
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Figure 7-2 Key and display operation
It will take 3 to 5 minutes for the capacitive touch key's self-calibration once the MAG 8000 
transmitter enclosure is removed and mounted again. There will be no response from the touch 
key during self-calibration.

7.2 Display symbols
Top area of display shows status bar.

Figure 7-3 Status bar
Status information symbols show actual operation of meter.
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Tariff symbol shows actual accounting tariff. In operator menu, tariff value will change to "r" if 
information is resettable.
Alarm symbol is active when an alarm is active and shown independently of alarm output 
configuration.
Empty pipe symbol indicates an empty pipe condition. To conserve power and prevent false 
readings due to exposed measurement electrodes, flow measurement is disabled until a full pipe 
is detected and the symbol has disappeared.
Power supply type is automatically detected by meter.
Plug symbol indicates that mains power is supplied.
Battery symbol indicates that battery power is supplied. It also indicates remaining battery 
capacity, see Operation menu index 1 (Page 66) for more information.
Bottom part of display shows menu bar.

Figure 7-4 Menu bar
The menu bar icons indicate actual selected menu and related index for selected information. 
Display overview shows relation between menu, index and information.
Only operator menu ( ) has information and functions that can be reset. During power-up 
function battery power can be preset to 100% capacity and time and date can be adjusted - an 
"A" in index shows acceptable values. The menu shown in each menu index is the menu bar.

7.3 Default display information and accessible display menus
Parameter 131 defines the default display information with selection between
• Totalizer 1 (Index 1)
• Totalizer 2 (Index 2)
• Actual flow rate (Index 3, updated with selected measuring frequency)
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• Fault codes (Index 4)
• Net totalizer

Default information is shown after power-up as well as after no key operation for 10 minutes.
Parameter 130 defines accessible display menus with selection of one or more of the following 
menus:
• Operator menu
• Meter info menu
• Service menu
• Data logger menu
• Statistic menu (advanced version only)
• Revenue menu (advanced version only)
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7.4 Operator menu
The operator menu consists of several indexes described in the following.
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Figure 7-5 Menu overview
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Index 1
Totalizer 1

Figure 7-6 Operator menu - Totalizer 1
Flow volume totalizer 1 (factory-configured for forward flow calculation).
For MAG 8000, the value of totalizer 1 can be reset to zero or set to any value desired via PDM 
or Flow Tool (example - replacing an existing old meter).

Index 2
Totalizer 2

Figure 7-7 Operator menu - Totalizer 2
Flow volume totalizer 2 (factory-configured for reverse flow). A negative value indicates reverse 
flow calculation.
For MAG 8000, the value of totalizer 2 can be reset to zero or set to any value desired via PDM 
or Flow Tool (example - replacing an existing old meter).

Index 3
Flow rate

Figure 7-8 Operator menu - Flow rate
Index 3 shows actual flow rate. If a negative value is indicated, flow is in reverse direction.
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MAG 8000 CT

Note
Reset of totalizer 1 or 2
For MAG 8000 CT, the value of totalizer 1 or 2 can only be reset to zero if verification sealing is 
broken and a hardware key is mounted on device. This is only allowed to be done by an 
authorized person, with the acceptance and under direction of the local authorities.

Note
Totalizer 3
• FW 3.09 and earlier: Customer resettable totalizer (following totalizer 1).
• FW 3.11 and later: Net totalizer protected by HW key in MAG 8000 CT.

Index 4
Active alarm

Figure 7-9 Operator menu - Active alarm
Faults are indicated with the lowest number first. The left of display indicates 3 alarm conditions: 
low power warning (5), leakage warning (L), and empty pipe warning (E).
Faults 1 to 4 affect meter performance and remain active until alarm condition disappears. Faults 
5 to d are warnings that will disappear when alarm condition has been corrected and they are 
reset via communication interface.
Fault evaluation and service guidelines are made in service section.
After all faults have disappeared, display shows total hours of faults until meter was reset.
Fault information. Each number indicates a dedicated fault:

1 Insulation fault
2 Coil current fault*)
3 Amplifier overload fault*)
4 Data base checksum fault
5 Low power warning (alarm limits are configurable)
6 Flow overload > Qmax. (Q4) (125% Qn) flow overload
7 Pulse output 1 overflow > PF [Hz] pulse output 1 overflow
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8 Pulse output 2 overflow > PF [Hz] pulse output 2 overflow
9 Consumption interval warning (alarm limits are configurable)
L Leakage warning (alarm limits are configurable)
E Empty pipe / low conductivity - when enabled*
C High conductivity / low impedance warning (alarm limits are configurable)
d High flow rate warning (alarm limits are configurable)
A Reverse high flow rate warning (alarm limits are configurable)

*) Meter disables measurement to reduce power consumption during fatal faults.

Index 5
Customer totalizer

Figure 7-10 Operator menu - Totalizer
The value of the customer totalizer can be reset to zero or set to any other value through SIMATIC 
PDM or Flow Tool.
For the CT version the totalizer is neither configurable nor resettable.

Display test

Figure 7-11 Operator menu - Display test
All segments of display are alternately flashed on and off during this test.
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Menu selection

Figure 7-12 Operator menu - Menu selection
If key is pressed shortly (2 to 5 seconds), menu selection will flash indicating that a new selection 
can be made.
After toggling to desired menu, a short press on key will enable chosen menu, which must be 
activated in parameter 130 in advance.

Index 0 (when active)
Call up reset

Figure 7-13 Operator menu - Call up reset
Call-up reset window (index 0) is only shown when call-up function is activated. "r" indicates that 
it can be reset by a long press on key. When releasing key while "r" is flashing, call-up function 
will be reset and window disappears.
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7.5 Internal data handling

Meter status
Meter status parameter (120) gives a fast indication of reliability of revenue data.
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Data logger / Consumption alarm
The integrated data logger has 26 logging periods in which data can be stored daily, weekly or 
monthly. The logger stores the consumption for totalizer 1 and totalizer 2 in the selected period. 
Forward consumption is stored as a positive value and reverse consumption is stored as a 
negative value. Alarm and meter status are also stored for the same period to indicate alarms 
that have been active, or that revenue data has been influenced in the specific period.

The logged information has a time and date stamp. The data logger never stops storing data - 
old data is overwritten following the first in/first out principle, i.e. log 1 is the last stored 
information which is moved to log 2 when the next logging is made and so on.
The consumption alarm indicates that the actual consumption on totalizer 1 is above or below 
the consumption limits.

Note
Invalid log date
If the log date "00.00.2000" is shown in the device display, the log period was never set.

7.6 Battery-powered operation
The MAG 8000 Standard (7ME6810) and MAG 8000 CT (7ME6820) are factory-configured for 7 
years of typical operation on internal battery pack (2 D-cell). High or low temperature, frequent 
use of IrDA communication, high pulse output rate, high excitation frequency in leakage 
detection mode, and use of add-on communication module will reduce actual operation time.
The MAG 8000 power management function controls each power consuming element and 
measures the temperature for optimal calculation of remaining battery power capacity.
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Battery status and alarm indication
Battery power capacity for operation is indicated in 3 levels.

Figure 7-14 Battery status
• Full symbol indicates battery capacity is above battery alarm level (% preset parameter 206).
• Low symbol indicates that battery should be replaced; however, measurement will remain 

active. Level is based on a preset alarm level.
• When low symbol is flashing, measurement and communication is disabled until battery 

pack has been replaced and reset.
"Low battery" is a selectable % (parameter 206) of 100% full capacity. The meter calculates the 
remaining capacity every four hours, including all consuming elements and the influence of 
temperature changes.

Consumption and operation time calculation
Battery operation time depends on connected battery pack as well as operation conditions of 
meter. Every 4 hours the advanced power management system calculates the real power 
consumption and remaining operation capacity.
Power consumption calculation includes flow measurement, meter dialog (communication and 
display) and pulse output.
Temperature is also measured to control and adjust its influence on the battery capacity.
The internal 2 D-cell battery pack has a nominal capacity of 33 Ah giving a typical operation of 
7 years for MAG 8000 Standard and MAG 8000 CT. The nominal capacity of external battery pack 
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(4 D-cell) is 66 Ah and gives typically 10 years operation time for MAG 8000 Standard and MAG 
8000 CT.

 

 

 

 

Scenario - Revenue application
Output A Pulse - 10 Hz
Output B Alarm or Call up
Meter dialog 1 hour per month
Excitation frequency 1/15 Hz
Country main frequency 50 Hz / 60 Hz

MAG 8000 Standard (7ME6810) and MAG 8000 CT (7ME6820)
Excitation frequency 
(24 hours operation)

1/60
Hz

1/30
Hz

1/15
Hz

1/5
Hz

1.5625 Hz 3.125
Hz

6.25
Hz

Two D-Cell bat‐
tery 33 Ah In‐
ternal battery 
pack

DN 25 to 150
(1" to 6")

9 years 9 years 7 years 43 months 8 months 3 months 2 months

DN 200 to 600
(8" to 24")

9 years 6 years 4 years 22 months 3 months 1 month N/A

DN 700 to 1200
(28" to 48")

7 years 4 years 2 years 1 year 1 month N/A N/A

Four D-Cell 
battery 66 Ah 
External bat‐
tery pack

DN 25 to 150
(1" to 6")

15 years 15 years 14 years 86 months 16 months 7 months 4 months

DN 200 to 600
(8" to 24")

15 years 13 years 8 years 44 months 7 months 3 months N/A

DN 700 to 1200
(28" to 48")

14 years 9 years 5 years 2 years 3 months N/A N/A

Typical operation time of 7 years is based on an operation time/temperature profile of 5% at 0 
°C (32 °F), 80% at 15 °C (59 °F) and 15% at 50 °C (122 °F), 0.1 % at menu 3 operation and 0.1 % 
at IrDA operation, and no use of add-on communication module.
Leakage detection (advanced version only) will affect battery operation time if a higher 
excitation frequency is selected during leakage period.
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The effect of other temperatures is shown in the figure below.

Figure 7-15 Available capacity of one D-cell battery in relation to discharge current and temperature

Note
Installation orientation of battery pack may influence battery capacity. Optimal battery capacity 
is achieved with battery pack in an upright position.

Note
Stop Modbus communication before changing the battery
In order to avoid a checksum error, stop Modbus communication before changing the battery.
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Battery configuration
The battery figures show power management information, which can be accessed via "Device" 
→ "Power".

At each battery replacement the actual battery capacity is reset to 100% (parameters 508 to 
510), which is then reduced with real meter consumption every 4 hours.
Power related alarm settings are located in "Alarm" group, e.g. "Battery limit" (parameter 206), 
which is the level at which low power alarm is activated generating an alarm or call-up (if 
configured), as well as low power fault related parameters 230 to 234.
When switching between battery power from the internal and the external battery packs, 
"Battery power" (parameter 507) must be adjusted to match the actual number of batteries 
connected.
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Service and maintenance 8
8.1 Maintenance

The device is maintenance-free. However, a periodic inspection according to pertinent directives 
and regulations must be carried out.   
An inspection can include check of:
• Ambient conditions
• Seal integrity of the process connections, cable entries, and cover screws
• Reliability of power supply, lightning protection, and grounds

NOTICE
Repair and service must be carried out by Siemens authorized personnel only.

Note
Siemens defines flow sensors as non-repairable products. 

WARNING
Impermissible repair and maintenance of the device
• Repair and maintenance must be carried out by Siemens authorized personnel only.

8.2 MAG 8000 service guidelines
The MAG 8000 battery-operated water meters are based on a very reliable measurement 
technology and the advanced alarm monitoring and diagnostics provide valuable information 
concerning the meter performance, faults, and service conditions.
Optimal meter performance requires proper meter selection, proper installation, and proper 
commissioning for the particular application. This service guideline section indicates how to 
detect and solve the most common problems. Meter and application problems are indicated by 
the alarm program via the main fault and warning symbol on the display and the comprehensive 
data logging and monitoring available via the communication interface.
Alarm monitoring includes individual registration of each alarm, how many hours the alarm has 
been active, when the alarm first appeared, and when it disappeared last. The alarm log can be 
reset with its own date and time registration. A common fault hour counter includes all active 
alarms in one counter. Additionally, active alarms are logged in the data logger to monitor when 
the alarms have been activated.
Fatal faults 1 through 4 are the most important to resolve as they influence the operation of the 
meter. Fatal faults will disappear as soon as the alarm condition is corrected.
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8.3 Replacing transmitter or PCB board
The MAG 8000 and MAG 8000 CT do not have a removable SENSORPROM. Therefore special care 
must be taken when replacing a damaged or defective transmitter or PCB board to ensure proper 
operation and continued accuracy. There are 3 ways to achieve an easy and successful 
replacement meter:
1. Order a transmitter replacement kit as a spare part, which comes with the factory default 

settings and original product label. To order you need to provide a serial number 087L4166 
is for compact version, 087L4202 is for remote version.

2. Order a complete transmitter as a spare part with default settings and a blank product label. 
Final configuration is done on-site. Missing data and configuration can be uploaded from the 
old meter, or it can be read from the old meter product label.

3. Order only a replacement PCB board. The PCB board can only be ordered for basic or 
advanced versions with default settings. When making the configuration on-site, the service 
mode must be selected in the Flow Tool/SIMATIC PDM and the hardware key must be 
mounted on the PCB board, to change important parameters.
Note
Re-verification
If MAG 8000 CT transmitter or sensor must be replaced, a re-verification of the whole water 
meter is necessary, to re-obtain custody transfer approval. The re-verification must be 
performed by an authorized person, with the acceptance and under direction of the local 
authorities.

Note
SITRANS F M Verificator
The SITRANS F M Verificator cannot be used with MAG 8000. 

8.4 Battery replacement

Condition
Only use the following battery type supplied by Siemens:
Internal battery pack (2D cells): A5E50698081
External battery pack (4D cells): A5E50698048
Ordering of spare parts (Page 119)
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Replacing battery
1. Loosen screws on transmitter top.
2. Remove transmitter top using a screwdriver.

3. Dispose of silica gel bag.
4. Replace O-ring to ensure continued IP68 enclosure rating.

– Check O-ring for damage or deformity.
– Smear O-ring with acid-free lubricating gel.

5. Push locking tab and loosen strip.

6. Remove battery pack with power still connected.
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7. Place and secure new battery pack.
Note
Battery packs must be installed with the top part in upwards direction to reach maximum 
capacity.

8. Add new Silica gel bag
– Remove plastic bag from new silica gel bag.
– Place new silica gel bag on top of battery pack to prevent condensation within meter.
– To maintain IP68 enclosure the silica gel bag may not be in contact with the potting 

compound.
9. Disconnect old battery pack and connect new one.
10.Press key within 6 seconds to reset battery (i.e. operating time and remaining capacity) when 

display shows:

11.Mount top lid.
12.Fasten screws to reassemble meter completely.

If necessary, adjust time and date via software, see "Power up with battery reset, date and time 
set up".

Note
Re-verification
All sealed MAG 8000 CT meters must be re-verified when sealings (marked "A") have been 
broken. The re-verification must be performed by an authorized person, with the acceptance 
and under direction of the local authorities.
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Figure 8-1 Verification sealings

8.5 Power up with battery reset, date and time set up

When new batteries have been installed, power-up procedure will enable resetting battery 
capacity and setting up date and time. Battery capacity reset, date and time can also be corrected 
via parameters 508 and 100.
When battery plug is connected, meter will display meter version for 10 seconds. Display will 
then show "rESEt.bAt" indicating the option to reset internal battery power calculation. To 
execute reset, press key within 6 seconds. If key is not pressed, meter will proceed to set date, 
set clock, and finally normal operation mode.
If key is pressed within reset battery time, display will indicate "Accept" to ensure that reset 
should take place. Reset will take place only if key is pressed again within the next 6 seconds. If 
not, normal operation will begin.
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For setting up date and time, the different key function must be used - see Operator menu 
(Page 66). An "A" indicates an acceptable value and a flashing "A" indicates that value is stored 
when key is released.
Reset function also sets actual date as battery replacement date.

8.6 Verification mode
Verification mode increases measurement frequency to provide maximum measurements per 
second. All other parameters stay the same. This function is especially useful to minimize 
calibration time when validating water meter accuracy. Frame around digits will blink slowly to 
indicate that verification mode is enabled. Maximum pulse rate on output A is increased to 1 kHz 
and pulse width is set to 0.5 ms. When verification mode is exited the previous pulse setting is 
restored. Pulse widths other than 1 ms can be selected by storing new pulse values. This setting 
remains when verification mode is exited.

Activation of verification mode
Verification mode is enabled in one of the following ways:
• Pressing verification button through hole in front screen.
• Writing integer ‘1’ to parameter 320.

Verification mode
The following indicate that meter is in verification mode:
• Frame surrounding digits in LCD starts flashing.
• Excitation frequency is set to maximum allowable frequency.

– (ExcitationFreqNo = ExcitationFreqNoLimit)
• Resolution in display is set to 3 digits after decimal point.

– (DecimalPoint = 3)
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Deactivation of verification mode
Verification mode is deactivated in one of the following ways:
• Pressing verification button again.
• Writing integer ‘0’ to parameter 320 (Calibration mode).
Verification mode automatically stops after 4 hours, unless manually deactivated.

8.7 Transport

NOTICE
Transport with fitted battery
If the battery is still present in the device when transporting, it could become loose as a result 
of vibrations and cause damage within the device.
• Remove the batteries before returning the device.
• Dispose of the batteries according to regulations or include them separately in the return 

consignment. 

8.8 Return procedure
To return a product to Siemens, see Returns to Siemens (www.siemens.com/returns-to-
siemens).
Contact your Siemens representative to clarify if a product is repairable, and how to return it. 
They can also help with quick repair processing, a repair cost estimate, or a repair report/cause 
of failure report.

NOTICE
Decontamination
The product may have to be decontaminated before it is returned. Your Siemens contact 
person will let you know for which products this is required.

Note
Return of products with lithium batteries   
Lithium batteries are dangerous goods according to the Regulation of Dangerous Goods, UN 
3090 and UN 3091. 
• Remove lithium batteries prior to shipment.
• If the battery cannot be removed, return the product according to the Regulation of 

Dangerous Goods with special transport documentation.
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8.9 Disposal
  Devices described in this manual should be recycled. They may not be dis‐

posed of in the municipal waste disposal services according to the Directive 
2012/19/EC on waste electronic and electrical equipment (WEEE).
Devices can be returned to the supplier within the EC and UK, or to a locally 
approved disposal service for eco-friendly recycling. Observe the specific 
regulations valid in your country.
Further information about devices containing batteries can be found at: 
Information about battery / product return (WEEE) (https://
support.industry.siemens.com/cs/document/109479891/)

8.9.1 Battery disposal
In accordance with EU directive 2006/66/EC, batteries are not to be disposed of via municipal 
waste disposal services.
Waste industrial batteries from our products are accepted back by Siemens and by the local 
Siemens representatives. Please follow the return procedures (Page 85) of Siemens or  talk to 
your local Siemens partner.
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Diagnostics and Troubleshooting 9
9.1 Fault codes

Error system
MAG 8000 can detect and report 13 different faults. 
The faults are divided into two types: Fatal errors and Warnings.
Fatal errors: Faults 1, 2, 3, and 4
Warnings: Faults 5, 6, 7, 9, L, E, C, d, and 14

Fault
codes

Name/text Description Cause Remedy

1 Insulation 
fault

"Cross-talk" between 
coil circuit and electro‐
des. An insulation fault 
will result in a offset er‐
ror on flow measure‐
ment
(Advanced version only)

• Defect cables between 
sensor and transmitter

• Wrong connections of 
remote cables

• Water between coils 
and electrodes – could 
be caused by a broken 
liner

• Pollution/moisture on 
PCB caused by water in 
encapsulation

Check cable and wiring installation and dis‐
turbing elements in the surrounding.
Re-activation of insulation test (parameter 
800) will reset alarm and start a new insu‐
lation test.
During the 4 minute insulation test, meas‐
urement is disabled.
Alarm remains active until a new test period 
detects no failures.

2 Coil current 
fault

Error in the coil circuit. 
Coil current has not set‐
tled within specified pe‐
riod.
A short-circuit in the coil 
can NOT be detected

• Coils have been discon‐
nected could be caused 
by broken cable or wires

Check cable and wiring installation.
Alarm remains active until the fault condi‐
tion is corrected.

3 Amplifier 
overload

Input signal is outside 
expected range.
Input amplifier circuit 
can not provide a stable 
measurement.
A short circuit between 
the two electrodes or 
between a electrode 
and common can NOT 
be detected

• Electrodes have been 
disconnected, or con‐
nected to ground

Check cable and wiring installation.
Alarm remains active until the fault condi‐
tion is corrected.
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Fault
codes

Name/text Description Cause Remedy

4 Database 
checksum

Corrupted data in ee‐
prom detected by check‐
sum test made during 
power-up

• Power failure during Ee‐
prom write

1. Reset checksum repair alarm via param‐
eter 560 and check data.
– All data is checked after operation 

(e.g., new flow calculation, writing 
to the EEprom, etc.) with a check‐
sum control. If the checksum result 
fails, data will not be considered as 
valid and repair data must be made.

2. If data is wrong or checksum error reoc‐
curs, replace the PCB board.

The alarm is active until the fault condition 
is corrected.

5 Low Power 
Alarm

Battery capacity is be‐
low preset threshold 
(default 10%).
Power up (temporary 
warning – will disap‐
pear after 4 hours)

• Battery capacity low
• Meter has been pow‐

ered up

Check calculated battery capacity (parame‐
ter 510) versus battery alarm limit (param‐
eter 206) and replace batteries if necessary
Flow measurement and communication 
stop, but display remains active as long as 
power is available.
The alarm remains active until the fault con‐
dition is resolved.

6 Flow Over‐
load

Flow rate has exceeded 
125% of Q3

• Wrong sizing – flow sen‐
sor too small

Check meter sizing for actual installation 
Alarm remains active until fault condition is 
resolved.

7 PulseA over‐
load

Duty cycle of output A 
has exceeded maxi‐
mum possible of 50

• Wrong settings for out‐
put A

Change volume per pulse to a higher value 
- see Technical data (Page 99) for pulse 
selection.
Note: Pulse A is limited to 100Hz.
The alarm remains active until output pulse 
rate drops below maximum pulse rate.

9 Consump‐
tion Interval

Accumulated volume 
on totalizer 1 during da‐
ta log period has excee‐
ded the too low or too 
high consumption limit

• Flowrate higher or low‐
er than expected

• Wrong parameter setup

Check data logger values and consumption 
limit.
Alarm remains active until it is manually re‐
set via parameter 209.

L Leakage Lowest flow rate or vol‐
ume during leakage pe‐
riod has exceeded leak‐
age detection settings

• Leakage in water net‐
work

Check setting and pipe installation.
Alarm is active until it is manually reset by 
parameter 208.
Alarm reset resets information as does leak‐
age period reset (parameter 820).

E Empty Pipe Measured electrode im‐
pedance has exceeded 
the empty-pipe detec‐
tion level (parameters 
540, 541 and 334)

• Pipe is not filled with wa‐
ter

Ensure sensor is filled with water.
Alarm remains active until fault condition is 
resolved.
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Fault
codes

Name/text Description Cause Remedy

C Low Impe‐
dance

Measured electrode im‐
pedance is below low 
impedance threshold 
(parameter 542), i.e. 
water has a high con‐
ductivity

• Water is polluted (e.g. 
saltwater in fresh water)

-
Alarm is active until water resistance is 
above low media alarm limit.

d Flow Limit The forward flow rate is 
greater than the high 
flow alarm limit (param‐
eter 553).

• Water network failure – 
pipe burst

-
Alarm remains active until flow rate drops 
below flow alarm limit.

A Reverse Flow 
Limit

Reverse flow rate is be‐
low a preset threshold 
(default -1E9)

• Water network failure – 
non-return valve is bro‐
ken

-
Alarm remains active until reverse flow rate 
drops below reverse flow alarm limit.

Note
Reset of fault log (parameter 204) also resets all alarms. Once reset, only active alarms become 
visible again.

9.2 Built-in functions

Empty pipe detection
Electrode impedance is measured with 800 Hz at 50 Hz mains frequency (960 Hz at 60 Hz mains 
frequency). This is done by toggling the electrode control pin every 6 respectively 5 samples – 
the sample frequency is 9600 Hz. The impedance value is averaged over 100 measurements. 
The electrode impedance A and B are measured in turns.
The unfiltered impedance value (a fast warning indication) is compared with a limit and the 
empty pipe warning is reported when it exceeds this limit – but only if the detection is ON and 
if there is no overload failure.
During empty pipe detection the coil current is held OFF and the flow value is forced zero.
Default settings for Electrode Impedance Limit is 25 000 ohm corresponding to a water 
conductivity of 20 µS/cm (10 000 ohm ≈ 50 µS/cm)

Insulation test
Insulation measurement is working like the normal measurement by excitation of the magnetic 
coils in the sensor. Value is checked against a default limit of 2.5 mm/s. A value above this limit 
results in a failure report. The "Insulation upper limit" can be adjusted through SIMATIC PDM or 
Flow Tool.
Measurement will NOT stop if an insulation fault occurs.
The last flow value is used for totalization during insulation test.
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Insulation test interval according to register "Insulation Test Interval". Minimum 1 day between 
tests.
The insulation test can be enabled/disabled with register "Insulation Test".
When the insulation test is enabled the test starts immediately. All following insulation tests will 
start at 00:00:00 (midnight). 
Duration of insulation test is 2 min 42 sec (1024 samples @ 6.25 Hz) 
Insulation test will always be made with an excitation frequency of 6.25 Hz.

Note
For firmware versions < 3.07: The insulation test cannot be enabled in the basic versions of MAG 
8000 and MAG 8000 CT.

Coil-current test
When H-bridge is turned and just before making samples (4 times each measurement), the coil 
current is checked via a comparator. If the coil current is not settled, a failure is reported.
During coil current failure the flow value is forced zero.

Amplifier test
Overload is possible both from the AD conversion of sensor signal and from the pre-amplifier. 
These checks are made at each sample and if one of the sample fails with an overload, this 
measurement is cancelled and a failure is reported.
During overload detection the coil current is held OFF and the flow value is forced zero.

Checking facilities
The MAG 8000 and MAG 8000 CT are equipped with checking facilities of types P, I, and N. (in 
OIML R49). The automatic checks are performed without operator intervention.
Type P permanent checking facilities are automatic checks performed constantly during meter 
operation. They include:
• Coil current test
• Amplifier test
• Empty pipe test
• Flow overload
• Pulse overload
Type I intermittent checking facilities are automatic checks performed at certain time intervals 
or per fixed number of measurements. They include:
• Checksum calculation (10 min. interval on totalizer checksum)
• Insulation test (minimum 24 hour interval)
• Battery capacity check (4 hours interval)

Diagnostics and Troubleshooting
9.2 Built-in functions

SITRANS FM MAG 8000 Battery-operated water meter
90 Operating Instructions, 08/2022, A5E03071515-AL



Type N non-automatic checking facilities are checks that are not performed automatically 
including all other diagnosis functions in the MAG 8000 and the MAG 8000 CT.

9.3 Flow simulation
MAG 8000 and MAG 8000 CT has a built-in flow simulator (parameters 551 and 552) to verify 
and adjust pulse output to any connected device or system.

WARNING
Totalized values are changed during simulation and actual flow is NOT measured.
Simulation will stop automatically in 4 hours.
For MAG 8000 CT flow simulation is forbidden.
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Technical specifications 10
10.1 MAG 8000 water meter

Note
Further information
For further information, see certificates. (http://www.siemens.com/processinstrumentation/
certificates)

Meter MAG 8000 Standard
(7ME6810)

MAG 8000 CT
(7ME6820)

Accuracy Standard calibration ± 0.4% of rate ± 2 mm/s -
Extended calibration ± 0.2% of rate ± 2 mm/s -
OIML R49:2013 - Class 1 (DN50-DN600) and 

Class 2 (DN50-DN600)
MI-001 according to 
2014/32/UE

- Q3/Q1=315 (DN50-DN300 hori‐
zontal), 

Q3/Q1=200 (DN350-DN600 hori‐
zontal)

NMI (Australia) ± 2.5% (Q1 ≲ Q ≲ Q4) -
Media conductivity  Clean water > 20 μs/cm
Temperature Ambient −20 to +60 °C

(−4 to +140 °F)
−25 to +55 °C

(−4 to +131 °F)
Media 0 to 70 °C

(+32 to +158 °F)
0.1 to 50 °C

(+32 to +122 °F)
Storage −40 to +70 °C

(−22 to +158 °F)
−40 to +70 °C

(−22 to +158 °F)
Rated operating 
conditions

Device installation indoor / outdoor / wet locations
Air humidity max. 100 %
Altitude max. 2000 m
Overvoltage category II
Pollution degree 2

Enclosure  IP68/NEMA 6P rating.
Cable glands mounted requires potting kit to remain IP68/NEMA 6P,

otherwise IP67/NEMA 4 rating is obtained.
Factory mounted cable provides IP68/NEMA 6P rating
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Meter MAG 8000 Standard
(7ME6810)

MAG 8000 CT
(7ME6820)

Approvals Drinking water approvals NSF 61 (cold water) USA
WRAS (BS 6920 cold water) UK

ACS Listed France
DVGW W270 Germany

Belgaqua (B)
AS/NZS 4020 

NSF 61 (cold water) USA
WRAS (BS 6920 cold water) UK

ACS Listed France
DVGW W270 Germany

Belgaqua (B)
AS/NZS 4020

KIWA
 Custody transfer approval NMI OIML R49:2013

OIML R 49
MI-001 (DK-0200-MI001-011)

NMI
KIWA

Conformity  - ISO 4064
PED 2014/68/EU
EMC EN 61326-1:2020
FM Fire Service Class Number 1044

For further features, see "Features" (Page 169).

10.2 Sensor

Technical specifications
Sensor MAG 8000

(7ME6810)
MAG 8000 CT

(7ME6820)
Size, flange and pressure 
range

EN 1092-1
(DIN 2501)

DN 25, DN 40, DN 350 - DN 600: PN 40
DN 50 to 150: PN 16

DN 200 to 1200: PN 10 or PN 16
DN 350 - DN 600: PN 25

DN 50 to 600: PN 16

ANSI 16.5
Class 150 lb

1" to 24": 20 bar (290 psi) 2" to 24": 16 bar (232 psi)

AWWA C-207 28" to 48": PN 10 -
AS 4087 DN 50 to 1200: PN 14 DN 50 to 600: PN 16
AS 2091-1
Table D

- -

AS 2191
Table E
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Sensor MAG 8000
(7ME6810)

MAG 8000 CT
(7ME6820)

Max. excitation frequency
Basic version

Battery-pow‐
ered

1/15 Hz for sensor size 
DN 25 to 150 (1" to 6")
1/30 Hz for sensor size 

DN 200 to 600 (8" to 24")
1/60 Hz for sensor size 

DN 700 to 1200 (28" to 48")

1/15 Hz for sensor size 
DN 50 to 150 (1" to 6")
1/30 Hz for sensor size 

DN 200 to 600 (9" to 24")

Mains-powered 6.25 Hz for sensor size 
DN 25 to 150 (1" to 6")

3.125 Hz for sensor size 
DN 200 to 600 (8" to 24")
1.5625 Hz for sensor size 

DN 700 to 1200 (28" to 48")

6.25 Hz for sensor size 
DN 25 to 150 (1" to 6")

3.125 Hz for sensor size 
DN 200 to 600 (8" to 24")

Max. excitation frequency
Advanced version

Battery-pow‐
ered

1/15 Hz for sensor size 
DN 25 ... 150 (1" ... 6") 

adjustable up to 6.25 Hz 
1/30 Hz for sensor size 

DN 200 … 600 (8" … 24") 
adjustable up to 3.125 Hz 

1/60 Hz for sensor size 
DN 700 ... 1200 (28" ... 48") 
adjustable up to 1.5625 Hz

1/15 Hz for sensor size 
DN 50 ... 150 (2" ... 6") 
adjustable up to 6.25 Hz
1/30 Hz for sensor size 

DN 200 … 600 (8" … 24") 
adjustable up to 3.125 Hz

Mains-powered 6.25 Hz for sensor size 
DN 25 ... 150 (1" ... 6")

3.125 Hz for sensor size 
DN 200 … 600 (8" … 24")
1.5625 Hz for sensor size 

DN 700 ... 1200 (28" ... 48")

6.25 Hz for sensor size 
DN 25 ... 150 (1" ... 6")

3.125 Hz for sensor size 
DN 200 … 600 (8" … 24")

Liner  EPDM EPDM
Electrode and grounding  Hastelloy C276 Hastelloy C276

10.3 Transmitter
Transmitter MAG 8000Standard

(7ME6810)
MAG 8000 CT

(7ME6820)
Installation  Integral (compact) or remote with factory-mounted cable in 5, 10, 20 or 30 m 

lengths 
with IP68/NEMA 6P connectors.

Connection is made at the transmitter bottom.
Material Top housing Stainless steel (AISI 316)

Wall mounting 
bracket

Stainless steel (AISI 304).
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Transmitter MAG 8000Standard
(7ME6810)

MAG 8000 CT
(7ME6820)

Display and key Display 8 digits for main information.
Index, menu and status symbols for dedicated information

Key For toggling through information and resetting of customer totalizer and call-up 
function

Menus Selectable default information and accessible menus:
- Operator

- Meter
- Service

- Data Logger
- Statistic (Advanced version only)

- Revenue and Tariffs (Advanced version only)
Resolution Totalized information can be displayed with 1, 2 or 3 decimals 

or automatic adjustment for maximum resolution
Flow unit Europe std. Volume: m3 

Flow rate: m3/h
US std. Volume: Gallon

Flow rate: GPM
Volume: m3 

Flow rate: m3/h
Australia std. Volume: ML

Flow rate: ML/d
Volume: m3 

Flow rate: m3/h
Other selectable 
units

Volume:
m3 x 100, L x 100, G x 100, G x 1000, 

MG,
CF x 100, CF x 1000, AF, Al, kL, BBL42

Flow rate:
m3/min, m3/h, m3/d, L/s, L/min, L/h, ML/

d, GPS, GPH, GPD, MGD, GPM, CFS, 
CFM, CFH, BBL42/s, BBL42/min, BBL42/

h, BBL42/d

-

Other units than m3 and m3/h (ordered 
from factory or manually configured 
on-site by changing scaling factors) 

are shown by a label stuck onto display
Digital output Nos. 2 passive outputs (MOS), individually galvanically isolated

Load Max. ± 35 V DC, 50 mA short circuit protected
Output A Programmable as:

Pulse volume, Forward, Reverse, Forward/net, Reverse/net
Output B Programmable as:

Pulse volume, Forward, Reverse, Forward/net, Reverse/net , Alarm, Call-up
Pulse rate Pulse A: Max. 100 Hz

Pulse B: Max. 50 Hz
Pulse width 5, 10, 25, 50, 100, 500 ms
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Transmitter MAG 8000Standard
(7ME6810)

MAG 8000 CT
(7ME6820)

Communication IrDA Standard integrated infrared communication interface with MODBUS RTU proto‐
col

Add-on modules RS 232 serial interface with MODBUS RTU (Rx/Tx/GND),
point to point with max. 15 m cable

RS 485 serial interface with MODBUS RTU (+/-/GND),
multidrop with up to 32 devices with max. 1000 m cable

Encoder interface module (for Itron 200WP) "Sensus protocol"
Wireless communication module with or without analog input cable

10.4 Power supply
Power supply
Battery power supply 1) Internal battery pack 1 D-Cell 3.6 V / 16 Ah

Internal battery pack 2 D-Cell 3.6 V / 33 Ah
External battery pack 4 D-Cell 3.6 V / 66 Ah

12-24 V AC/DC power supply Input voltage range 12/24 V AC/DC (10 ... 32 V DC)
Power consumption 2 VA
Isolation Class II
Fuse 1000 mA T - Not replaceable
Short circuit protection Module is protected from short circuit on the output con‐

nector. Both during mains and backup supply
Conformity IEC 61010-1

OIML R49:2013
EMC: EN 61326-1

115 to 230 V AC mains supply Input voltage range 115 to 230 V AC, +15% to −20%, 50-60 Hz
Power consumption 2 VA
Isolation Class II
Fuse 250 mA T - Not replaceable
External circuit breaker2) 10 A … 16 A
Short circuit protection Module is protected from short circuit on the output con‐

nector. Both during mains and backup supply in the range 
of 10 A … 16 A

Conformity IEC 61010-1
OIML R49:2013
EMC:
EN 61326-1
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Power supply
Input cable for 
12/24 V AC/DC and 
115 to 230 V AC power supply

Factory-mounted PUR cable 2 x 1 mm2 (brown, blue)
Length = 3 m

Resistance Sunlight and water
Outer diameter 7 mm (0.28")
Rated voltage 300 ... 500 V AC
Testing voltage 2000 V AC
Temperature range Fixed laying: 

Flexible application: 
−40 to +90 °C (-40 to 194 °F)
−30 to +80 °C (-22 to 176 °F)

Bending radius Min. 28 mm (fixed installation)
Pulling force Max. 200 N
Output Socket
Backup battery Plug

1) Lithium batteries are subject to special transportation regulations according to United Nations 
"Regulation of Dangerous Goods, UN 3090 and UN 3091". Special transport documentation is 
required to observe these regulations. This may influence both transport time and costs.
2) Circuit breaker must be marked as the disconnecting device for the equipment

10.5 Modbus RTU
Siemens Flow Instruments Modbus RTU specification for add-on modules
Device type Slave
Baud rates 1200, 2400, 4800, 9600, 19 200, 38 400 bits/sec.
Number of stations Recommended: max. 31 per segment without repeaters for RS 485
Device address range 1 to 247
Protocol RTU

(Other Modbus protocols like ASCII, Plus or TCP/IP are not supported)
Electrical interface RS 485, 2-wire and RS 232, 2-wire
Connecter type Screw terminals
Supported function codes 1: read coils
 3: read holding registers
 5: write single coil
 16: write multiple registers
 17: report slave ID
Broadcast Yes
Maximum cable length 1200 meters (@38 400 bps)
Standard Modbus over serial line v1.0
Certified No
Device profile None
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Siemens Flow Instruments Modbus RTU specification for add-on modules
Add-on modules comply with MODBUS over serial line specification & implementation guide v. 1.0

modbus.org 12/02/02
MODBUS application protocol specification v. 1.1
modbus.org 12/06/02

Isolation 500 V AC functional isolation of data signals and common

Add-on modules must be connected to equipment complying with "Low Voltage Directive" in 
order to be considered safe. The isolation within the MAG 8000 and MAG 8000 CT add-on 
MODBUS module is only functional isolation.

10.6 Output characteristics
This chapter describes how the MAG 8000 and MAG 8000 CT outputs work.

Output A and B as pulse volume

①  Forward PR Pulse rate
②  Reverse PF Pulse frequency
③  Cut-off PW Pulse width

MAG 8000
When output A or B is configured as volume per pulse, the output delivers a pulse when the 
preset volume based on either Forward/Reverse or Net Forward/Net Reverse flow has passed the 
sensor in the selected direction. The volume per pulse is freely scalable, from 0.000001 to 10 
000 units per pulse, and should not exceed the pulse rate of the output configuration table.
MAG 8000 CT
The volume per pulse is defined in the MAG 8000 CT version to 0.001 or 0.01 or 0.1 or 1 m3 per 
pulse.
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Output B as alarm output

① Alarm output
② Alarm status
③ On - Off
④ No Error

MAG 8000
When output B is configured as an "alarm" output, it will follow the internal alarms that were 
previously chosen in the Alarm Configuration List (Page 55).

Note
Alarm output is inverted to a pulse output providing an alarm if power disappears or cable 
connection is interrupted.

Output B as call-up output

① Call up output
② Call up reset
③ Call up status
④ On - Off

When output B is configured as "call-up", the output is activated by an alarm condition and 
remains on until it is reset via meter display key or communication interface.
A new alarm will not activate a "call-up" function if the "call-up" function is still active from a 
previous alarm.

Note
Like alarm output, call-up output inverts to a pulse output providing a call-up if power disappears 
or cable connection is interrupted.

MAG 8000
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When output B is configured as an "call-up" output, it will follow the internal alarms that were 
previously chosen in the Alarm Configuration List.

Note
Call-up output is inverted to a pulse output providing an alarm if power disappears or cable 
connection is interrupted.

Regional factory default settings
DN
mm

size
(inch)

Pulse width
ms

Amount per 
pulse
m3 (Europe)

Amount per 
pulse
Gallons (USA)

Amount per 
pulse
ML (Australia)

25, 40, 50 (1", 1½", 2") 50 0.01 1 0.001
65, 80, 100, 125, 150 (2½", 3", 4", 5", 6") 50 0.1 10 0.001
200, 250, 300, 350,
400, 450, 500

(8", 10", 12", 14",
16", 18", 20")

50 1 100 0.01

600, 700, 800, 900,
1000, 1050, 1100, 1200

(24", 28", 30", 32", 36",
40", 42", 44", 48")

50 10 100 0.01

Pulse A is set to ON - Forward flow. Pulse B is set to Alarm.

Note
Via the MLFB order system is it possible to select other units than the default region units. The 
pulse output will only be enabled if the pulse settings are selected in the MLFB no.

Pulse output, volume selection (MAG 8000)
DN
(inches)

Max.
flow
rate Qn
(Q3)

Guidelines for min. volume per pulse at Qn
Volume [m3] = Qn [m3/s] * (2*PW [s])

(inches) m3 5 ms 
PW m3

[100Hz]

10 ms
PW m3

[50Hz]

50 ms
PW m3

[10Hz]

50 ms 
PW gallon
[10Hz]

50 ms 
PW ML
[10Hz]

100 ms
 PW m3

[5Hz]

500 ms
 PW m3

[1Hz]
25 (1") 17.67 0.00005 0.0001 0.0005 0.130 0.000001 0.001 0.005
40 (1½") 45 0.0001 0.0003 0.001 0.330 0.000001 0.003 0.013
50 (2") 63 0.0002 0.0004 0.002 0.462 0.000002 0.004 0.018
65 (2½") 100 0.0003 0.0006 0.003 0.734 0.000003 0.006 0.028
80 (3") 160 0.0004 0.0009 0.004 1.174 0.000004 0.009 0.044
100 (4") 250 0.0007 0.0014 0.007 1.835 0.000007 0.014 0.069
125 (5") 400 0.0011 0.0022 0.011 2.935 0.000011 0.022 0.111
150 (6") 630 0.0018 0.0035 0.018 4.623 0.000018 0.035 0.175
200 (8") 1000 0.0028 0.0056 0.028 7.338 0.000028 0.056 0.278
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DN
(inches)

Max.
flow
rate Qn
(Q3)

Guidelines for min. volume per pulse at Qn
Volume [m3] = Qn [m3/s] * (2*PW [s])

(inches) m3 5 ms 
PW m3

[100Hz]

10 ms
PW m3

[50Hz]

50 ms
PW m3

[10Hz]

50 ms 
PW gallon
[10Hz]

50 ms 
PW ML
[10Hz]

100 ms
 PW m3

[5Hz]

500 ms
 PW m3

[1Hz]
250 (10") 1600 0.0044 0.0089 0.044 11.741 0.000044 0.089 0.444
300 (12") 2500 0.0069 0.0139 0.069 18.345 0.000069 0.139 0.694
350 (14") 3463 0.0096 0.0192 0.096 25.412 0.000096 0.192 0.962
400 (16") 4523 0.0126 0.0251 0.126 33.190 0.000126 0.251 1.256
450 (18") 5725 0.0159 0.0318 0.159 42.010 0.000159 0.318 1.590
500 (22") 7068 0.0196 0.0393 0.196 51.865 0.000196 0.393 1.963
600 (24") 10178 0.0283 0.0565 0.283 74.687 0.000283 0.565 2.827
700 (28") 13854 0.0385 0.0770 0.385 101.662 0.000385 0.770 3.848
750 (30") 15904 0.0442 0.0884 0.442 116.705 0.000442 0.884 4.418
800 (32") 18095 0.0503 0.1005 0.503 132.782 0.000503 1.005 5.026
900 (36") 22902 0.0636 0.1272 0.636 168.057 0.000636 1.272 6.362
1000 (40") 28274 0.0785 0.1571 0.785 207.477 0.000785 1.571 7.854
1050 (42") 31175 0.0866 0.1732 0.866 228.750 0.000866 1.732 8.659
1100 (44") 34211 0.0950 0.1901 0.950 251.043 0.000950 1.901 9.503
1200 (48") 40715 0.1131 0.2262 1.131 298.770 0.001131 2.262 11.310

PW = pulse width

Note
The calculated numbers of pulses are an average of the measuring period.
The factory value of pulse width shall be 10ms by if Z option L70-L74 for pulse A or L90-L94 for 
pulse B selected.
For MAG 8000 CT please see definition of Q3 flow rates in the certificates for OIML R 49 or MI 001.

Net flow output
The MAG 8000 has a special net pulse output that includes bi-directional flow calculations. 
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The example shows that over time, the net pulse output indicates the bi-directional totalizer as 
calculated internally. The same principle applies for forward and reverse flow calculation. By 
changing the status of the pulse output, the internal pulse calculator will be reset.

Flow Net totalizer in 
meter display

(Bi-directional)

Pulse output forward Uni-direc‐
tional mode 
Volume [m3]

Pulse output net forward Bi-direc‐
tional mode
Volume [m3]

Volume [m3] Internal calcula‐
tion

Delivered vol‐
ume

Internal calcula‐
tion

Delivered vol‐
ume

 

 

0 - 0 0 0

 

 

10 - 10 0 10

 

 

−2 - 0 -12 0

 

 

18 - 20 −12+20= 8

Total accounted volume
[m3]
Forward/Reverse
 
 

18F  30F  18F
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Encoder output interface read out
 MSD LSD  
Digits in MAG 8000 display 1 2 3 4 5 6 7 8   
Model Size Unit Display configuration Q3 Digits after

dec. point
7ME 6820 2Y DN50 (2") m3 0 0 0 0 0 0 0 0 63 1
7ME 6820 3F DN65 (2½") m3 0 0 0 0 0 0 0 0 100 1
7ME 6820 3M DN80 (3") m3 0 0 0 0 0 0 0 0 160 1
7ME 6820 3T DN100 (4") m3 0 0 0 0 0 0 0 0 250 1
7ME 6820 4B DN125 (5") m3 0 0 0 0 0 0 0 0 400 1
7ME 6820 4H DN150 (6") m3 0 0 0 0 0 0 0 0 630 1
7ME 6820 4P DN200 (8") m3 0 0 0 0 0 0 0 0 1000 1
7ME 6820 4V DN250 (10") m3 0 0 0 0 0 0 0 0 1600 1
7ME 6820 5D DN300 (12") m3 0 0 0 0 0 0 0 0 1600 1

Parameter 305 Decimal Point should be configured to "1 digit after decimal point" in case 
Encoder interface module is selected in MAG 8000 or MAG 8000 CT; otherwise proper reading 
from the device cannot be performed.

10.7 Meter uncertainty
To ensure continuous accurate measurement, water meters must be calibrated. The calibration 
is conducted at Siemens flow facilities with traceable instruments referring directly to the 
physical unit of measurement according to the International System of Units (SI).
Therefore, the calibration certificate ensures recognition of the test results worldwide, including 
the US (NIST traceability).
Siemens offers accredited calibrations assured to ISO 17025 in the flow range from 0.0001 m³/
h to 10 000 m³/h.
Siemens Flow Instruments accredited laboratories are recognized by ILAC MRA (International 
Laboratory Accreditation Corporation- Mutual Recognition Arrangement) ensuring 
international traceability and recognition of the test results worldwide.
The selected calibration determines the accuracy of the water meter. An extended calibration of 
the MAG 8000 (7ME6810) sizes DN50 (2") to DN 300 (12") results in a max. ±0.2% of rate ±2 mm/
s uncertainty. A calibration certificate is included with every sensor and calibration data is stored 
within the meter.
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1

2

① MAG 8000 Stand‐
ard

Standard calibra‐
tion

±0.4 % of rate ±2 mm/s

② MAG 8000 Stand‐
ard

Extended calibra‐
tion

±0.2 % of rate ±2 mm/s

Calibration references conditions (ISO 9104 and DIN EN 29104)
Media temperature: 20°C ± 5K (68°F ± 9°F)
Ambient temperature: 20°C ± 5K (68°F ± 9°F)
Warming-up time: 30 min.
Incorporation in pipe section
Inlet section: 10 x DN
Outlet section: 5 x DN
Flow conditions: Fully developed flow profile

10.8 FM Fire Service applications (MAG 8000 and MAG 8000 CT)
Devices ordered with Z-option P20, P21 or P22 are FM Fire Service approved for automatic fire 
protection systems according to the Fire Service Meters Standard, Class Number 1044. The 
approval is applicable for the sizes DN 50, DN 80, DN 100, DN 150, DN 200, DN 250, and DN 300 
(2", 3", 4", 6", 8", 10", and 12") with ANSI B16.5 Class 150 flanges.

FM-Fire Service verification tolerances 

1.5 %

Q
max

Q
min

±E%
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10.9 MAG 8000 CT (7ME6820) (Revenue program) water meter type 
approval

MAG 8000 CT program is type-approved according to international water meter standard OIML 
R49:2013. The Custody Transfer program is approved as Class I and Class II, for the sensor 
program from DN 50 to DN 600, at different Q3 and Q3/Q1.
Q2/Q1 = 1.6 and follows standard OIML R49 specification.

Table 10-1 OIML R49:2013 for Class 1 (not approved for bi-directional measurements)
Size 50 

(2")
65 
(2½")

80 
(3")

100 
(4")

125 
(5")

150 
(6")

200 
(8")

250 
(10")

300 
(12")

350 
(14")

400 
(16")

450 
(18")

500 
(20")

600 
(24")

"R" Q3/Q1 200 125
Q4 [m3/h] 78.75 125 200 312.5 500 787.5 1250 2000 2000 3125 5000 5000 7875 7875
Q3 [m3/h] 63 100 160 250 400 630 1000 1600 1600 2500 4000 4000 6300 6300
Q2 [m3/h] 0.504 0.8 1.28 2 3.2 5.04 8 12.8 12.8 32 51.2 51.2 80.64 80.64
Q1 [m3/h] 0.315 0.5 0.8 1.25 2 3.15 5 8 8 20 32 32 50.4 50.4

Table 10-2 OIML R49:2013 for Class 2
Size 50 

(2")
65 
(2½")

80 
(3")

100 
(4")

125 
(5")

150 
(6")

200 
(8")

250 
(10")

300 
(12")

350 
(14")

400 
(16")

450 
(18")

500 
(20")

600 
(24")

"R" Q3/Q1 315 200
Q4 [m3/h] 78.75 125 200 312.5 500 787.5 1250 2000 2000 3125 5000 5000 7875 7875
Q3 [m3/h] 63 100 160 250 400 630 1000 1600 1600 2500 4000 4000 6300 6300
Q2 [m3/h] 0.32 0.508 0.813 1.27 2.032 3.2 5.079 8.127 8.127 20 32 32 50.4 50.4
Q1 [m3/h] 0.2 0.317 0.508 0.794 1.27 2 3.175 5.079 5.079 12.5 20 20 31.5 31.5

10.10 MAG 8000 CT (7ME6820) (Revenue program) MID option (MI-001)
MAG 8000 CT program is type approved according to international water meter standard OIML 
R49. Since 1 November 2006 the MI-001 water meter directive has been in force, which means 
that all water meters can be sold across the EU borders if the water meters contain a MI-001 label.
The MAG 8000 CT MI-001 verified and labeled products are equivalent to OIML R49 accuracy 
Class 2 according to Directive 2014/32/EU of the European Parliament and Council of February 
26, 2014 on measuring instruments (MID), Annex MI-001 in the sizes from DN 50 to DN 600.

Technical specifications
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The MID certification is obtained as a module B and module D approvals according to the above 
mentioned directive.
Module B : Type approval according to OIML R49
Module D : Quality insurance approval of production

MAG 8000 CT MI-001 verified and labelled products at a given Q3 and Q4/Q3 = 1.25 and Q2/Q1 
= 1.6 measuring ranges see below table:

Size 50 
(2")

65 
(2½")

80 
(3")

100 
(4")

125 
(5")

150 
(6")

200 
(8")

250 
(10")

300 
(12")

350 
(14")

400 
(16")

450 
(18")

500 
(20")

600 
(24")

"R" Q3/Q1 40
Q4 [m3/h] 20 31.25 50 78.75 125 200 312.5 500 787.5 787.5 1250 2000 3125 5000
Q3 [m3/h] 16 25 40 63 100 160 250 400 630 630 1000 1600 2500 4000
Q2 [m3/h] 0.64 1 1.6 2.52 4 6.4 10 16 25.2 25.2 40 64 100 160
Q1 [m3/h] 0.4 0.63 1 1.58 2.5 4 6.25 10 15.75 15.75 25 40 62.5 100

Size 50 
(2")

65 
(2½")

80 
(3")

100 
(4")

125 
(5")

150 
(6")

200 
(8")

250 
(10")

300 
(12")

350 
(14")

400 
(16")

450 
(18")

500 
(20")

600 
(24")

"R" Q3/Q1 63
Q4 [m3/h] 20 31.25 50 79 125 200 312.5 500 788 1250 2000 3125 5000 7875
Q3 [m3/h] 16 25 40 63 100 160 250 400 630 1000 1600 2500 4000 6300
Q2 [m3/h] 0.41 0.64 1.02 1.6 2.54 4.07 6.35 10.16 16 25.4 40.63 63.5 101.5

9
160

Q1 [m3/h] 0.26 0.4 0.64 1 1.59 2.54 3.97 6.35 10 15.88 25.4 39.69 63.49 100

Size 50 
(2")

65 
(2½")

80 
(3")

100 
(4")

125 
(5")

150 
(6")

200 
(8")

250 
(10")

300 
(12")

350 
(14")

400 
(16")

450 
(18")

500 
(20")

600 
(24")

"R" Q3/Q1 80
Q4 [m3/h] 31.25 50 79 125 200 312.5 500 788 1250 2000 3125 3125 5000 7875
Q3 [m3/h] 25 40 63 100 160 250 400 630 1000 1600 2500 2500 4000 6300
Q2 [m3/h] 0.5 0.8 1.26 2 3.2 5 8 12.6 20 32 50 50 80 126
Q1 [m3/h] 0.32 0.5 0.79 1.25 2 3.13 5 7.88 12.5 20 31.25 31.25 50 78.75

Size 50 
(2")

65 
(2½")

80 
(3")

100 
(4")

125 
(5")

150 
(6")

200 
(8")

250 
(10")

300 
(12")

350 
(14")

400 
(16")

450 
(18")

500 
(20")

600 
(24")

"R" Q3/Q1 160
Q4 [m3/h] 50 79 125 200 312.5 500 788 1250 2000 3125 5000 5000 7875 7875
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Size 50 
(2")

65 
(2½")

80 
(3")

100 
(4")

125 
(5")

150 
(6")

200 
(8")

250 
(10")

300 
(12")

350 
(14")

400 
(16")

450 
(18")

500 
(20")

600 
(24")

Q3 [m3/h] 40 63 100 160 250 400 630 1000 1600 2500 4000 4000 6300 6300
Q2 [m3/h] 0.4 0.63 1 1.6 2.5 4 6.3 10 16 25 40 40 63 63
Q1 [m3/h] 0.25 0.40 0.63 1 1.57 2.5 3.94 6.25 10 15.63 25 25 39.38 39.38

Size 50 
(2")

65 
(2½")

80 
(3")

100 
(4")

125 
(5")

150 
(6")

200 
(8")

250 
(10")

300 
(12")

350 
(14")

400 
(16")

450 
(18")

500 
(20")

600 
(24")

"R" Q3/Q1 200
Q4 [m3/h] 78.75 125 200 312.5 500 787.5 1250 2000 2000 - - - - -
Q3 [m3/h] 63 100 160 250 400 630 1000 1600 1600 - - - - -
Q2 [m3/h] 0.51 0.8 1.28 2 3.2 5.04 8 12.8 12.8 - - - - -
Q1 [m3/h] 0.32 0.5 0.8 1.25 2 3.15 5 8 8 - - - - -

Size 50 
(2")

65 
(2½")

80 
(3")

100 
(4")

125 
(5")

150 
(6")

200 
(8")

250 
(10")

300 
(12")

350 
(14")

400 
(16")

450 
(18")

500 
(20")

600 
(24")

"R" Q3/Q1 250
Q4 [m3/h] 78.75 125 200 312.5 500 787.5 1250 2000 2000 - - - - -
Q3 [m3/h] 63 100 160 250 400 630 1000 1600 1600 - - - - -
Q2 [m3/h] 0.41 0.64 1.03 1.6 2.56 4.04 6.4 10.24 10.24 - - - - -
Q1 [m3/h] 0.26 0.4 0.64 1 1.6 2.52 4 6.4 6.4 - - - - -

Operating Conditions
Environment class E2, M1
Climatic class -25…55 °C, condensing, closed
Verification tolerance ±5 % Q1 < Q < Q2

±2 % Q2 ≤ Q ≤ Q4 
Unit of measurement Cubic meters
Temperature T30 (0.1 °C - 30 °C) / tested up to T50 according to OIML R49:2013
Pressure PN ≔ 16 bar or PN ≔ 10 bar or PN ≔ 6 bar
Power supply 3.6 V Lithium Battery, 12 - 24 VAC/VDC, 115 - 230 VAC
Compact/Remote Max. 30 m cable
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10.11 The effect of temperature MAG 8000 (7ME6810) and MAG 8000 CT 
(7ME6820)

Metric (Pressures in bar)
Flange spec. Flange rating Temperature °C

0 10 50 70
Sizes 25 mm, 40 mm and > 300 mm
EN 1092-1 PN 10 10.0 10.0 9.7 9.4

PN 16 16.0 16.0 15.5 15.1
PN 40 40.0 40.0 38.7 37.7

ANSI 16.5 150 lb 19.7 19.7 19.3 18.0
Sizes 50 mm to 300 mm
EN 1092-1 PN 10 10.0 10.0 10.0 8.2

PN 16 10.0 16.0 16.0 13.2
ANSI 16.5 150 lb 10.0 19.7 19.7 16.2

Imperial (Pressures in Psi)
Flange spec. Flange rating Temperature °F

32 50 122 158
Sizes 1", 1½", and > 12"
EN 1092-1 PN 10 145 145 141 136

PN 16 232 232 225 219
PN 40 580 580 561 547

ANSI 16.5 150 lb 286 286 280 261
Sizes 2" to12"
EN 1092-1 PN 10 145 145 145 119

PN 16 145 232 232 191
ANSI 16.5 150 lb 145 286 286 235
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Dimension drawings 11
Meter dimensions

Dimensions for MAG 8000 Standard (7ME6810) and MAG 8000 CT (7ME6820).

Nominal 
size 
DN

A L, length D, diameter Weight 1)
AS 4087
PN 16

EN 1092-1 ANSI
16.5
CI.150

AS 
4087
PN 16

AS 
2129 
Table E

AWWA DI D
PN 
10

PN 
16

PN 
40

mm (inch) mm 
(inch)

mm mm m
m

inch mm mm mm inch mm (inch)  kg lbs

25 (1") 194 (7.7") - - 20
0

7.9" 200 200 N/A N/A 25 (0.98") 2) 6 13

40 (1½") 204 (8.1") - - 20
0

7.9" 200 200 N/A N/A 40 (1.57") 2) 9 20

50 (2") 195 (7.7") - 200 - 7.9" 200 - N/A N/A 42 (1.65") 2) 11 25
65 (2½") 201 (8") - 200 - 7.9" 200 - N/A N/A 55 (2.17") 2) 13 29
80 (3") 207 (8.2") - 200 - 7.9" 200 - N/A N/A 67 (2.64") 2) 15 34
100 (4") 214 (8.5") - 250 - 9.8" 250 - N/A N/A 81 (3.19") 2) 17 38
125 (5") 224 (8.9") - 250 - 9.8" 250 250 N/A N/A 101 (3.98") 2) 22 50
150 (6") 239 (9.5") - 300 - 11.8" 300 - N/A N/A 131 (5.16") 2) 28 63
200 (8") 264 

(10.5")
350 350 - 13.8" 350 - N/A N/A 169 (6.65") 2) 50 113

250 (10") 291 
(11.5")

450 450 - 17.7" 450 - N/A N/A 212 (8.35") 2) 71 160
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Nominal 
size 
DN

A L, length D, diameter Weight 1)
AS 4087
PN 16

EN 1092-1 ANSI
16.5
CI.150

AS 
4087
PN 16

AS 
2129 
Table E

AWWA DI D
PN 
10

PN 
16

PN 
40

mm (inch) mm 
(inch)

mm mm m
m

inch mm mm mm inch mm (inch)  kg lbs

300 (12") 317 
(12.6")

500 500 - 19.7" 500 - N/A N/A 265 (10.43") 2) 88 198

350 (14") 369 
(14.6")

550 550 - 21.7" 550 - N/A N/A 350 (13.78") 2) 127 279

400 (16") 394 
(15.6")

600 600 - 23.6" 600 - N/A N/A 400 (15.75") 2) 145 318

450 (18") 425 
(16.8")

600 600 - 23.6" 600 - N/A N/A 450 (17.72") 2) 175 394

500 (20") 450 
(17.8")

600 600 - 23.6" 600 - N/A N/A 500 (19.68") 2) 225 494

600 (24") 501 
(19.8")

600 600 - 23.6" 600 - N/A N/A 600 (23.62") 2) 340 747

700 (28") 544 
(21.4")

700 875 - N/A 700 - 700 27.6
"

700 (27.55") 2) 316 694

750 (30") 571 
(22.5")

N/A N/A - N/A N/A - 750 29.5
"

750 (29.52") 2) N/A N/A

800 (32") 606 
(23.9")

800 1000 - N/A 800 - 800 31.5
"

800 (31.49") 2) 398 1045

900 (36") 653 
(25.7")

900 1125 - N/A 900 - 900 35.4
"

900 (35.42") 2) 476 1045

1000 (40") 704 
(27.7")

1000 1250 - N/A 1000 - 1000 39.4
"

1000 
(39.36")

2) 602 1322

1050 (42") 704 
(27.7")

N/A N/A - N/A N/A - 1050 41.3
"

1050 
(41.33")

2) N/A N/A

1100 (44") 755 
(29.7")

N/A N/A - N/A N/A - 1100 43.3
"

1100 
(43.30")

2) N/A N/A

1200 (48") 810 
(31.9")

1200 1500 - N/A 1200 - 1200 47.2
"

1200 
(47.23")

2) 887 1996

1) For remote version the sensor weight is reduced with 2 kg (4.5 lb)
2) See flange table (Page 111) 
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Remote version

Figure 11-1 Dimensions in mm (inch), weight 3.5 kg (8 lbs)

Flange dimensions

MAG 8000 (7ME8610) and MAG 8000 CT (7ME6820)
Dimensions mm Bolting
Size D PCD T B Holes Bolts
PN 10
200 340 295 24 22 8 M20
250 395 350 26 22 12 M20
300 445 400 26 22 12 M20
350 505 460 28 22 16 M20
400 565 515 32 26 16 M24
450 615 565 36 26 20 M24
500 670 620 38 26 20 M24
600 780 725 42 30 20 M27
700 895 840 - 30 24 M27
750 - - - - - -
800 1015 950 - 33 24 M30
900 1115 1050 - 33 28 M30
1000 1230 1160 - 36 28 M33
1050 - - - - - -
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Dimensions mm Bolting
Size D PCD T B Holes Bolts
1100 - - - - - -
1200 1455 1380 - -39 32 M36
PN 16
50 165 125 19 18 4 M16
65 185 145 20 18 8 M16
80 200 160 20 18 8 M16
100 220 180 22 18 8 M16
125 250 210 22 18 8 M16
150 285 240 24 22 8 M20
200 340 295 26 22 12 M20
250 405 355 29 26 12 M24
300 460 410 32 26 12 M24
350 520 470 35 26 16 M24
400 580 525 38 30 16 M27
450 640 585 42 30 20 M27
500 715 650 46 33 20 M30
600 840 770 52 36 20 M33
750       
800 1015 950 - 33 24 M30
900 1125 1050 - 39 28 M36
1000 1255 1170 - 42 28 M39
1050 - - - - - -
1100 - - - - - -
1200 1485 1390 - 48 32 M45
PN 40
25 115 85 16 14 4 M12
40 150 110 18 18 4 M16

MAG 8000 (7ME8610) and MAG 8000 CT (7ME6820)
Dimensions Inches Bolting
Size D PCD T B Holes Bolts
ANSI Class 150
1" 4.25 3.12 0.56 0.62 4 9/16"
1 ½" 5 3.88 0.68 0.62 4 9/16"
2" 6 4.75 0.75 0.75 4 5/8"
2 ½" 7 5.5 0.88 0.75 4 5/8"
3" 7.5 6 0.94 0.75 4 5/8"
4" 9 7.5 0.94 0.75 8 5/8"
5" 10 8.5 0.94 0.88 8 3/4"
6" 11 9.5 1 0.88 8 3/4"
8" 13.5 11.75 1.12 0.88 8 3/4"
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Dimensions Inches Bolting
Size D PCD T B Holes Bolts
10" 16 14.25 1.19 1.00 12 7/8"
12" 19 17 1.25 1.00 12 7/8"
14" 21 18.75 1.38 1.12 12 1"
16" 23.5 21.25 1.44 1.12 16 1"
18" 25 22.75 1.56 1.25 16 1 1/8"
20" 27.5 25 1.69 1.25 20 1 1/8"
24" 32 29.5 1.88 1.38 20 1 1/4"

External battery pack and cable

Note
Physical orientation of battery pack may influence battery capacity.
Optimal battery capacity is achieved with battery pack in an upright position as shown.

The cable for the battery pack connection must be ordered separately.
For information about battery disposal, see Battery disposal (Page 86).
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Grounding rings
Sizes DN 25 to 300 (7ME6810 and 7ME6820)

Figure 11-2 Flat ring

Sizes DN 350 to 600 (7ME6810 and 7ME6820) and DN 700 to 1200 (7ME6810)

Figure 11-3 Type C grounding ring

Dimension drawings
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Product documentation and support A
A.1 Product documentation

Process instrumentation product documentation is available in the following formats: 
• Certificates (http://www.siemens.com/processinstrumentation/certificates)   
• Downloads (firmware, EDDs, software) (http://www.siemens.com/processinstrumentation/

downloads) 
• Catalog and catalog sheets (http://www.siemens.com/processinstrumentation/catalogs) 
• Manuals (http://www.siemens.com/processinstrumentation/documentation) 

You have the option to show, open, save, or configure the manual.
– "Display": Open the manual in HTML5 format
– "Configure": Register and configure the documentation specific to your plant
– "Download": Open or save the manual in PDF format
– "Download as html5, only PC": Open or save the manual in the HTML5 view on your PC

You can also find manuals with the Mobile app at Industry Online Support (https://
support.industry.siemens.com/cs/ww/en/sc/2067). Download the app to your mobile device 
and scan the device QR code.

Product documentation by serial number
Using the PIA Life Cycle Portal, you can access the serial number-specific product information 
including technical specifications, spare parts, calibration data, or factory certificates.

Entering a serial number
1. Open the PIA Life Cycle Portal (https://www.pia-portal.automation.siemens.com).
2. Select the desired language.
3. Enter the serial number of your device. The product documentation relevant for your device 

is displayed and can be downloaded.
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login or 
register.

Scanning a QR code
1. Scan the QR code on your device with a mobile device.
2. Click "PIA Portal".
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login or 
register.

SITRANS FM MAG 8000 Battery-operated water meter
Operating Instructions, 08/2022, A5E03071515-AL 117

http://www.siemens.com/processinstrumentation/certificates
http://www.siemens.com/processinstrumentation/downloads
http://www.siemens.com/processinstrumentation/downloads
http://www.siemens.com/processinstrumentation/catalogs
http://www.siemens.com/processinstrumentation/documentation
https://support.industry.siemens.com/cs/ww/en/sc/2067
https://support.industry.siemens.com/cs/ww/en/sc/2067
https://www.pia-portal.automation.siemens.com


A.2 Technical support

Technical support
If this documentation does not completely answer your technical questions, you can enter a 
Support Request (http://www.siemens.com/automation/support-request). 
For help creating a support request, view this video here. 
Additional information on our technical support can be found at Technical Support (http://
www.siemens.com/automation/csi/service).   

Service & support on the Internet 
In addition to our technical support, Siemens offers comprehensive online services at Service & 
Support (http://www.siemens.com/automation/service&support).

Contact 
If you have further questions about the device, contact your local Siemens representative at 
Personal Contact (http://www.automation.siemens.com/partner).
To find the contact for your product, go to "all products and branches" and select "Products & 
Services > Industrial automation > Process instrumentation".
Contact address for business unit: 
Siemens AG
Digital Industries
Process Automation
Östliche Rheinbrückenstr. 50 
76187 Karlsruhe, Germany

Product documentation and support
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Spare parts/Accessories B
B.1 Ordering of spare parts

Condition
• You have a Siemens Industry Mall account.

Procedure
1. Open the PIA Life Cycle Portal (https://www.pia-portal.automation.siemens.com).
2. Select the desired language.
3. To find spare parts for your device, do one of the following:

– Enter the complete order number of your device (e.g. 7ME4633-4KA51-8DC3-Z 
A05+B11+E06+F11) into the "Product number" field and click "Go".

– Enter the serial number of your device (e.g. N1KXXXXXXX) in the "Serial number" field 
and click "Go".

– If you do not know the product or serial number, search for your device under "Product 
family".

4. Navigate to the "Spare parts" tab.
You see the list of spare parts available for your device.

5. Select a spare part and add it to your watch list.
The watch list opens.

6. Click "Add to cart of Industry Mall".

The Siemens Industry Mall opens and you can order your spare part.
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Flow Tool C
C.1 Flow Tool

Condition
In order to commission the water meter, it is necessary to install the Flow Tool program/software 
on your computer and connect the IrDA communication adaptor in the built-in IrDA 
communication interface on transmitter. The Flow Tool software is compatible with Windows 
2000, Windows XP, and Windows 7 32/64 bit.
Read Flow Tool FAQ and Release Note installed with the Flow Tool software.
Go to Siemens Industry Online Support (https://support.industry.siemens.com/cs/products?
dtp=Download&mfn=ps&pnid=17328&lc=en-US) to download the latest version of the Flow 
Tool.

Device driver
The Device Drivers are related to meter version and is automatically selected in "Automatic" 
mode. In "Manual" mode, meter version is manually selected and version check is automatically 
made when data is uploaded or downloaded.

Data backup
Meter information is stored in an internal data prom that secures data in case of power failure.
Information like totalizer 1 and 2, date and time, and the statistic data in Advanced version is 
stored every 10 minutes. Every 4 hours battery consumption is calculated and remaining battery 
capacity is updated together with "operation time since first power up" and "battery operation 
time".

C.2 Initial commissioning via Flow Tool
This chapter describes how to start up commissioning via Flow Tool software.
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Connecting PC to meter
Connect IrDa communication adaptor to its interface on transmitter and connect PC to adaptor.

Figure C-1 MAG 8000 or MAG 8000 CT has a built-in IrDA communication interface on top of meter. IrDA 
adaptor can be fixed to lid by rubber band.

Starting Flow Tool software program
Double-click on Flow Tool icon on windows desktop to start program.

Note
For on-line communication make sure the IrDA symbol is visible in the toolbar status menu 
before starting Flow Tool.

C.3 Configuring the device
This chapter describes how to set up meter for communication with PC. The options in both Flow 
Tool and SIMATIC PDM software are the same; only the views on the PC screen differ.
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Setting up meter
1. Right-click on "Project".
2. Select "New".
3. Select "Flow Meter".

4. Name device.
5. Select configuration type ("Automatic" or "Manual").
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"Automatic" configuration is selected if PC is 
connected directly to meter.

 "Manual" configuration is selected if configu‐
ration is made without any connection to a 

meter.
Configuration is downloaded to the meter af‐

terwards. 

C.4 Setting the basic parameters
Note
No factory reset
The device is delivered with factory settings that are not stored as default values. Because no 
default values are present in the meter, an automatic return to factory values is not possible. 

Flow Tool
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Setting parameters
The meter information is password-protected. The default factory password is "1000" and can be 
changed after gaining access to the meter. The password can be reset using a hardware key, 
see Data protection (Page 59).

Read, write, print or export meter data
A single parameter or a parameter group to be read, written, printed or exported to a CSV file.
Only parameters (data) shown on white background can be changed. Red texts are off-line data 
which are not stored in the MAG 8000 yet, whereas black texts show the actual meter data.
Each parameter has a description (prompt) advising how the parameter can be programmed and 
which settings are programmable.
The figure below shows alarm status with the marked alarms enabled.
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Figure C-2 Alarm status - marked alarms are enabled

Customer-selected parameter list
The default parameter list is divided into various functional groups with maximum 99 
parameters included. For a complete parameter overview, see "Parameter lists" in the appendix.
Customized parameter list can be configured by creating a new parameter folder.
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Figure C-3 Creating new parameter folder
Copy any existing parameter to the new folder. These parameters are updated and handled as 
the original parameters and listed in the same order as copied to the customized parameter list.
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Figure C-4 Customer-specified parameter list
There is no limitation on the number of customer-specified parameter lists. 
Saving the project will make the parameter list configuration available for future use.

Note
Saving the file with only the customized parameter list expanded will make future monitoring 
and changes of parameters easier.

See also
www.siemens.com/flow (www.siemens.com/flow)

C.5 Unit selection
MAG 8000 and MAG 8000 CT are delivered with totalizer and flow rate units as ordered via the 
MLFB structure.
The standard MAG 8000 units for each region are:
• Europe: m3 for totalizer and m3/h for flow rate
• US: Gallon for totalizer and GPM (Gallon per minute) for flow rate
• Australia: ML for totalizer and ML/d (Mega liter/day) for flow rate
The following MAG 8000 units and combinations are available:
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C.5 Unit selection

SITRANS FM MAG 8000 Battery-operated water meter
128 Operating Instructions, 08/2022, A5E03071515-AL

http://www.siemens.com/flow


Volume: m3, m3 × 100, L × 100, Gallon, G × 100, G × 1000, MG, CF × 100, CF × 1000, AF, AI, kl, 
ML, BBL42
Flow rate: m3/min, m3/h, m3/d, L/s, L/min, L/h, ML/d, GPS, GPM, GPH, GPD, MGD, CFS, CFM, CFH, 
BBL42/s, BBL42/min, BBL42/h, BBL42/d
The MAG 8000 CT format for all regions is:
• m3 for totalizer and m3/h for flow rate
To ensure selection of correct conversion factor, see unit conversion table in appendix.

All measurement units are printed on a label affixed to the display (except the European version). 
Some meter sizes have a factor included to secure the 8 digit display value will not overrun after 
short time of operation. Manual configuration of new units is allowed. A new sticker showing 
the new settings must then be affixed to the display.

Protected parameters
The following parameters are protected by HW key (for a complete overview of paramters go 
to Parameter lists (Page 145)):

MAG 8000 Standard / MAG 8000 CT MAG 8000 CT (additionally)
Parameter no. Parameter name Parameter no. Parameter name
5 Sensor tube diameter 100 Actual date and time
8 Totalizer unit 101 Totalizer 1
9 Flow unit 102 Totalizer 2
10 Qn (Q3) 103 Net totalizer (since FW 3.11)
11 Poduct code number 201 Alarm configuration list
12 Meter serial number 206 Battery alarm limit
300 Totalizer unit factor 303 Operation excitation frequency
301 Flow unit factor 305 Decimal point place
302 Pipe size 307 Measurement direction
306 Dsplayed unit 310 Flow direction totalizer 1
321 Calibration date 312 Flow direction totalizer 2
323 Calibration factor 327 Adjustment factor
325 Sensor offset 328 Low flow cut-off
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MAG 8000 Standard / MAG 8000 CT MAG 8000 CT (additionally)
Parameter no. Parameter name Parameter no. Parameter name
332 Max. sensor frequency excitation 329 Filter time constant
506 Numbers of power up 333 Empty pipe detection
520 Calibration temperature 334 Empty pipe impedance
522 Temperature calibration start 420 Device Communication Address
840 Tariff control mode 511 Communication module type
842 Tariff 1 period time end 550 Coil current active
844 Tariff 1 upper limit range 551 Fix flow mode active
845 Tariff 2 period time end 552 Fixed flow value
847 Tariff 2 upper limit range 805 Insulation upper limit
848 Tariff 3 period time end
850 Tariff 3 upper limit range
851 Tariff 4 period time end
853 Tariff 4 upper limit range
854 Tariff 5 period time end
856 Tariff 5 upper limit range
857 Reset tariff values

Hardware key
To gain access to protected parameters a hardware key must be installed. The hardware key hole 
is located in front part of PCB behind battery, see connection diagram (Page 35).

Note
Hardware key on MAG 8000 CT
For MAG 8000 CT only authorized persons, with the acceptance and under direction of the local 
authorities are allowed to use the hardware key.

Changing units

Note
Not allowed on MAG 8000 CT
This function is not allowed on MAG 8000 CT.

1. Select service mode and meter version – upload data from meter.
2. Open transmitter.
3. Remove battery (keep connected).
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4. Attach hardware key to PCB board (for correct attachment, see upper part of figure).

5. Change units description in parameters 8 and 9, see Unit conversion table.
6. Change units factor in parameters 300 and 301, see Unit conversion table.
7. Change maximum flow rate Qn (Q3) to new unit selection in parameter 10.
8. Select display unit in parameter 306.
9. Download each parameter to meter.
10.Remove hardware key.
11.Re-assemble meter.

Note
Important
The service mode opens many parameters. If these parameters are changed, it can seriously 
affect meter accuracy and operation. Be careful when writing new parameter values as meter 
has no default settings to return to.

C.6 Output configuration
Pulse output can be configured as volume pulse, alarm or call-up. Default factory setting is with 
output A enabled for forward flow and output B for alarm output.

Output configuration in Flow Tool
Select "I/O and Com.Setup". The software window shows the parameters for output 
configuration. Each parameter has its own guideline for selecting the correct parameter setting.
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To see how the outputs work, please see "Output characteristics" (Page 99).

C.7 Default display information and accessible display menus
Parameter 131 defines default display information with selection between
• Totalizer 1 (Index 1)
• Totalizer 2 (Index 2)
• Flow rate (Index 3, updated with selected measuring frequency)
• Fault codes (Index 4)
• Customer totalizer (Index 5 - resettable)
Default information is shown after power-up as well as after no key operation for 10 minutes.
Parameter 130 defines accessible display menus with selection of one or more of the following 
menus:
• Operator menu
• Meter info menu
• Service menu
• Data logger menu
• Statistic menu (advanced version only)
• Tariff menu (advanced version only)
Disabling display of menu data will not affect operation of functions.
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C.8 Internal data handling

Meter status
Meter status parameter (120) gives a fast indication of reliability of revenue data.

It shows whether important information has been reset or manipulated, for instance if meter has 
been powered down.
Status information can only be reset while hardware key is mounted.

Data logger / Consumption alarm
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The integrated data logger has 26 logging periods in which data can be stored daily, weekly or 
monthly. The logger stores the consumption for totalizer 1 and totalizer 2 in the selected period. 
Forward consumption is stored as a positive value and reverse consumption is stored as a 
negative value. Alarm and meter status are also stored for the same period to indicate alarms 
that have been active, or that revenue data has been influenced in the specific period.

The logged information has a time and date stamp. The data logger never stops storing data - 
old data is overwritten following the first in/first out principle, i.e. log 1 is the last stored 
information which is moved to log 2 when the next logging is made and so on.
The consumption alarm indicates that the actual consumption on totalizer 1 is above or below 
the consumption limits.

C.9 Battery configuration
Battery figures (generated as customer parameter list, see section Customer-selected parameter 
list in chapter Setting the basic parameters show power management information.

Figure C-5 Battery configuration
At each battery replacement the capacity is reset to 100% (parameters 508 to 510) which is then 
reduced with the real meter consumption every 4 hours.
The battery limit (parameter 206) is the level at which the low power alarm is activated 
generating an alarm or call-up (if configured). The power status (parameter 513) follows the 
battery symbol on the display.
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When switching between battery power from internal and external battery packs, "Battery 
power" (parameter 507) must be adjusted to match the actual number of batteries connected.
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Qualification certificate D
The qualification certificate is an enhancement of the PDM tool which enables printing of a MAG 
8000 status report using the MAG 8000 IrDA communication port and the MODBUS RTU 
protocol.

Note
Scope
The MAG 8000 Qualification Certificate is a qualification report of device functionality and NOT 
a tool for measurement accuracy verification like the MAG VERIFICATOR (FDK-083F5060 or 
FDK-083F5061). 

The MAG 8000 uses two main physical components for communication:
• The IrDA sensor on the MAG 8000
• An IrDA interface cable

D.1 Commissioning
The qualification certificate is generated from PDM via the following steps:
1. Enabling insulation test
2. Uploading the device data to the PC
3. Generating the qualification certificate
Finally, the service technicians must evaluate the result.
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D.2 Enabling insulation test
The insulation test must be carried out on the advance version of  the MAG 8000 or MAG 8000 
CT before generating the Qualification Certificate. The procedures for enabling the insulation 
test are shown below.
Set "Insulation test enable" to "Yes" if not already enabled.

Select “Device” → “Download to Device …” to download the change to the device.

Qualification certificate
D.2 Enabling insulation test
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Wait at least three minutes after downloading the change to the device before carrying out the 
first insulation test. Further details are available in section “Insulation test” in chapter "Built-in 
functions" (Page 89).

D.3 Uploading the device data to the pc
Select "Device" → "Upload to PC/PG" to load all device parameters from the device to the pc.

Qualification certificate
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D.4 Generating the qualification certificate

When the device data is completely read to the pc, select "Device" → "Qualification Certificate".

The qualification certificate tool is protected by a service password that is only available for 
service specialists.

Qualification certificate
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After entering the password, click "OK". Then click "Generate qualification certificate" in the next 
dialog box. A progress bar shows the percentage of the process.

Qualification certificate
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D.5 Result evaluation
The service technicians shall inspect the device parameters on the report and cross-check with 
the reference values to evaluate if the device status is of proper quality or not. Reference values 
are available in the document Qualification Certificate Reference Guideline (https://
support.industry.siemens.com/cs/ww/en/view/109750126).
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Unit conversion table E
Totalizer / Volume unit (parameter 8) Correction factor parameter 300
Default 1 m3

m3*100 0.01
Gallon (US) 264.1721
G*100 (100*Gallon) 2.641721
G*1000 (1000*Gallon) 0.2641721
MG (1000000*Gallon) 0.0002641721
AI (Acre Inches) 0.009728558
AF (Acre ft) 0.0008107132
CF*100 (100*ft3) 0.3531467
CF*1000 (1000*ft3) 0.03531467
L*100 (liter) 10
kL (1000*liter) 1
ML (Mega liter) 0.001
BBL42 (US oil barrel) 6.289810743

Flow rate unit (parameter 9) Correction factor parameter 301
Default 1 m3/s
m3/min (m3/minute) 60
m3/h (m3/hour) 3600
m3/d (m3/day) 86400
GPS (Gallon/second) 264.1721
GPM (Gallon/minute) 15850.32
GPH (Gallon/hour) 951019.4
GPD (Gallon/day) 22824465
MGPD (1000000*Gallon/day) 22.824465
CFS (ft3/second) 35.31467
CFM (ft3/minute) 2118.882
CFH (ft3/hour) 127132.8
L/s (liter/second) 1000
L/min (liter/minute) 60000
L/h (liter/hour) 3600000
ML/d (1000000*liter/day) 86.4
BBL42/s 6.289810743
BBL42/min 377.3886446
BBL42/h 22643.31867
BBL42/d 543439.6482
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Unit conversion table
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Parameter lists F
Parameter lists   

MAG 8000 is delivered with factory settings that are not stored as default values. Because 
defaults values are not present in the meter, an automatic return to factory values is not possible. 
The default settings are available at Siemens Industry Online Support (https://
support.industry.siemens.com/cs/products?dtp=Download&mfn=ps&pnid=17328&lc=en-US) 
under the Flow Tool entry. The Flow Tool is required to be able to read the default settings file.
Visible display information is indicated in the table by menu and index number. Remember to 
enable displayed menus in parameter 130.
The abbreviations used in the display menu table are: Operator menu = O, Meter menu = M, 
Service menu = Se, Data Logger menu = L, Statistic menu = St, Revenue menu = R.
Factory settings marked in italic cannot be edited.

Note
Change of units
If the unit and factor is changed, all unit-related values become invalid.
It is recommended to reset all unit-related values.

F.1 1-99
Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
1 All M1 Application identifier Identity Max. 15 characters.

Only numbers are visible in the 
display (letters are shown as 
"_")

2 All - Application location Location Max. 16 characters
3 All M3 Module type MLFB dependent MAG 8000 Basic

MAG 8000 Advanced
MAG 8000 CT Basic
MAG 8000 CT Advanced
MAG 8000 Irrigation

4 All M4 Software version  x.xx
5 All - Sensor size Sensor related Max. 12 characters.

DN 25 to 1200 (1" to 48")
6 All - Vendor name Siemens Siemens
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
8 All - Totalizer unit MLFB dependent Max. 12 characters
9 All - Flowrate unit MLFB dependent Max. 12 characters
10 All - Qn (Q3) Sensor related 0 to 1x109

11 All - Product code number 7ME6810, 7ME6820 or 
7ME6880

 

12 All - Serial number XXXXXXHXXX Max. 12 characters

F.2 100-199
Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
100 All M2 Actual date and time PS3 production date and 

time
year-month-day T
hours:minutes:seconds

101 All O1 Totalizer 1 0 0 to ±2x109

102 All O2 Totalizer 2 0 0 to ±2x109

103 All O5 Totalizer 3 0 0 to +±2x109

106 All - Flow rate  0 to 1.25 Qn (Q3)
107 All - Actual velocity Measured value ±15 m/s
108 All - Flowrate percent value  0 to 125% (Q4)
120 All - Actual flow meter status  0 to 255, binary presented with 

information 1 for bit 0
1: Totalizer 1 or 2 changed or re‐
set
2: Tariff setting changed or reset,
3: Tariff register changed or reset
4: Date - time changed
5: Alarm have been active
6: Fault log has been reset
7: Hardware key has been activa‐
ted
8: Meter has been powered up
If none of the above is active, no 
flag is set
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
130 All - Menu active 63=all menus active 0 to 63, binary presented with 

information
1 for bit 0
1: Operator menu
2: Meter info menu
3: Service menu
4: Log menu
5: Statistic menu
6: Revenue menu
If none of the above is active, the 
message is: None active

131 All - Default operator menu index Totalizer 1 Totalizer 1, Totalizer 2, Actual 
Flow rate, Fault codes, Customer 
Totalizer

F.3 200-299
Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
200 All O4 Fault status No faults 0 to 8191, binary presented with 

information 1 for bit 0
1: Insulation error
2: Coil current error
3: Amplifier overload
4: Database checksum error
5: Low power warning
6: Flow overflow warning
7: Pulse A overload warning
9: Consumption interval warning
10/L: Leakage warning
11/E: Empty pipe warning
12/C: Low impedance (high con‐
ductivity) warning
13/d: High flow limit warning
14/A: Reverse flow warning
If no error/warning is pending, 
the message is "No faults"

201 All - Alarm configuration list 254 = Alarm 2 to 8 enabled 0 to 8191, See 200
If no alarm is enabled, the mes‐
sage is "None enabled"
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
202 All - Date of fault log reset PS3 production date and 

time
year-month-day T hours:mi‐
nutes:seconds

203 All O4 Non optimal measure time, in‐
cluding the time of device run‐
ning with insulation test fault, 
coil current fault, amplifier 
fault, database checksum 
fault, flow overload fault, or 
empty pipe fault.

0  

204 All - Reset the fault log and faults No Yes / No
Value is reset to "No" when up‐
loading device parameters to pc 
after command execution

205 All - Call up acknowledge No Yes / No 
Value is reset to "No" when up‐
loading device parameters to pc 
after command execution

206 All - Battery alarm level 10% 0 to 100%
208 All - Reset leakage fault No Yes / No 

Value is reset to "No" when up‐
loading device parameters to pc 
after command execution

209 All - Reset consumption log fault No Yes / No 
Value is reset to "No" when up‐
loading device parameters to pc 
after command execution

210 All - Insulation alarm output ena‐
ble

No Yes / No

211 All - Insulation fault hours 0  
212 All - Insulation fault counter 0  
213 All - Insulation fault appears 2000-01-01 T 00:00:00  
214 All - Insulation fault disappears 2000-01-01 T 00:00:00  
215 All - Coil current alarm output en‐

able
Yes Yes / No

216 All - Coil current fault hours 0  
217 All - Coil current fault counter 0  
218 All - Coil current fault appears 2000-01-01 T 00:00:00  
219 All - Coil current fault disappears 2000-01-01 T 00:00:00  
220 All - Amplifier alarm output ena‐

ble
Yes Yes / No

221 All - Amplifier fault hours   
222 All - Amplifier fault counter   
223 All - Amplifier fault appears 2000-01-01 T 00:00:00  
224 All - Amplifier fault disappears 2000-01-01 T 00:00:00  
225 All - Database alarm output ena‐

ble
Yes Yes / No
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
226 All - Database fault hours 0  
227 All - Database fault counter 0  
228 All - Database fault appears 2000-01-01 T 00:00:00  
229 All - Database fault disappears 2000-01-01 T 00:00:00  
230 All - Low power alarm output en‐

able
Yes Yes / No

231 All - Low power fault hours 0  
232 All - Low power fault counter 0  
233 All - Low power fault appears 2000-01-01 T 00:00:00  
234 All - Low power fault disappears 2000-01-01 T 00:00:00  
235 All - Flow overflow alarm output 

enable
Yes Yes / No

236 All - Overflow fault hours 0  
237 All - Overflow fault counter 0  
238 All - Overflow fault appears 2000-01-01 T 00:00:00  
239 All - Overflow fault disappears 2000-01-01 T 00:00:00  
240 All - Pulse A overload alarm out‐

put enable
Yes Yes / No

241 All - Pulse A overload fault hours 0  
242 All - Pulse A overload fault counter 0  
243 All - Pulse A overload fault appears 2000-01-01 T 00:00:00  
244 All - Pulse A overload fault disap‐

pears
2000-01-01 T 00:00:00  

245 All with 
FW 3.12 
and lat‐
er 

- Pulse B overload alarm output 
enable 

Yes Yes / No 

246 All with 
FW 3.12 
and lat‐
er 

- Pulse B overload fault hours 0  

247 All with 
FW 3.12 
and lat‐
er 

- Pulse B overload fault counter 0  

248 All with 
FW 3.12 
and lat‐
er 

- Pulse B overload fault appears 2000-01-01 T 00:00:00  

249 All with 
FW 3.12 
and lat‐
er 

- Pulse B overload fault disap‐
pears 

2000-01-01 T 00:00:00  

250 All - Consumption alarm output 
enable

No Yes / No
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
251 All - Consumption fault hours 0  
252 All - Consumption fault counter 0  
253 All - Consumption fault appears 2000-01-01 T 00:00:00  
254 All - Consumption fault disappears 2000-01-01 T 00:00:00  
255 All - Leakage alarm output ena‐

ble
No Yes / No

256 All - Leakage fault hours 0  
257 All - Leakage fault counter 0  
258 All - Leakage fault appears 2000-01-01 T 00:00:00  
259 All - Leakage fault disappears 2000-01-01 T 00:00:00  
260 All - Empty pipe alarm output en‐

able
No Yes / No

261 All - Empty pipe fault timer 0  
262 All - Empty pipe fault counter 0  
263 All - Empty pipe fault appears 2000-01-01 T 00:00:00  
264 All - Empty pipe fault disappears 2000-01-01 T 00:00:00  
265 All - Low impedance alarm out‐

put enable
No Yes / No

266 All - Low impedance fault hours 0  
267 All - Low impedance fault counter 0  
268 All - Low impedance fault appears 2000-01-01 T 00:00:00  
269 All - Low impedance fault disap‐

pears
2000-01-01 T 00:00:00  

270 All - High flow alarm output ena‐
ble

No Yes / No

271 All - High flow alarm fault timer 0  
272 All - High flow alarm fault counter 0  
273 All - High flow alarm fault appears 2000-01-01 T 00:00:00  
274 All - High flow alarm fault disap‐

pears
2000-01-01 T 00:00:00  

275 All - Reverse high flow alarm out‐
put enable

No Yes / No

276 All - Reverse high flow alarm fault 
hours

0  

277 All - Reverse high flow alarm fault 
counter

0  

278 All - Reverse high flow appears 2000-01-01 T 00:00:00  
279 All - Reverse high flow disappears 2000-01-01 T 00:00:00  
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F.4 300-399
Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
300 All - Totalizer volume unit factor MLFB-dependent 0 to 1*x010

301 All - Flow unit factor MLFB-dependent 0 to 1*x010

302 All - Pipe size Sensor-related 25 to 1200
303 All - Meter excitation frequency 

(in battery power mode)
1/15 Hz 1/60 Hz, 1/30 Hz, 1/15 Hz, 1/5 Hz, 

1.5625 Hz, 3.125 Hz, 6.25 Hz
304 All - Mains frequency MLFB-dependent 50 or 60 Hz mains
305 All - Decimal point MLFB-dependent No point, One digit after point, Two 

digits after point, Three digits after 
point, Automatic point adjust

306 All - Displayed unit Use m3 unit Displayed m3 unit or an arrow indica‐
tion for a unit label

307 All - Measurement direction MLFB-dependent Bidirectional, Forward only, Reverse 
only

310 All - Flow direction totalizer 1 Forward Forward, Reverse or Bi-directional net 
flow

311 All - Totalizer 1 changes date PS3 production date and 
time

 

312 All - Flow direction totalizer 2 MLFB-dependent Forward, Reverse or Bi-directional net 
flow

313 All - Totalizer 2 changes date PS3 production date and 
time

 

320 All - Verification mode enable No Yes / No 
Value is reset to "No" when uploading 
device parameters to pc after four 
hours

321 All - Calibration date Calibration date year-month-day T hours:minutes:sec‐
onds

323 All - Calibration factor Sensor-related  
324 All - Gain correction Sensor-related  
325 All - Sensor offset Sensor-related  
327 All - Adjustment Factor 1 -2 to 2
328 All - Low flow cut-off MAG 8000 Standard 

(7ME6810) 0.05 % for 
FW 3.07 and lower. For 
FW 3.09 see table F-1 
below.

0 to 9.9 %

MAG 8000 CT 
(7ME6820) 0.25 % for 
FW 3.07 and lower. For 
FW 3.09 see table F-2 
below.
15 mm/s for FW 3.11 on‐
wards

0 to 999 mm/s

329 All - Filter time constant 5 Tau 1 to 1000
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
331 All - Excitation frequency limit 6.25 Hz for advanced 

version and 1/15 Hz for 
basic version

 

332 All - Excitation frequency sensor 
limit

Sensor-related 7ME6810 and 7ME6820:
6.25 Hz 
(DN 25 to 200 (1" to 8"))
3.125 Hz 
(DN 250 to 600 (10" to 24"))
1.5625 Hz 
(DN 700 to 1200 (28" to 48"))
7ME6880:
3.125 Hz
(DN 25 to 600 (1" to 24"))
1.5625 Hz
(DN 700 to 1200 (28" to 48"))

333 All - Empty pipe detection enable Yes Yes / No
334 All - Empty pipe limit 25000 ohm 0 to 2.15x109

Table F-1 MAG 8000 Standard (7ME6810) parameter 328 FW 3.09
Sensor size Parameter value
DN 25 (1") 0.16
DN 40 (1½") 0.15
DN 50 (2") 0.17
DN 65 (2½") 0.18
DN 80 (3") 0.17
DN 100 (4") 0.17
DN 125 (5") 0.17
DN 150 (6") 0.15
DN 200 (8") 0.17
DN 250 (10") 0.17
DN 300 (12") 0.15
DN 350 (14") 0.15
DN 400 (16") 0.15
DN 450 (18") 0.15
DN 500 (20") 0.15
DN 600 (24") 0.15
DN 700 (27½") 0.15
DN 750 (29½") 0.15
DN 800 (31") 0.15
DN 900 (35") 0.15
DN 1000 (39") 0.15
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Sensor size Parameter value
DN 1050 (41") 0.15
DN 1100 (43") 0.15
DN 1200 (47") 0.15

Table F-2 MAG 8000 CT (7ME6820) parameter 328 FW 3.09
R (Q3/Q1) no verifi‐

cation
63 80 160 200 250 100 with 

no verifi‐
cation

250 with 
no verifi‐
cation

DN 50 (2") 0.17 0.66 0.66 0.27 0.27 0.27 0.42 0.17
DN 65 (2½") 0.18 0.72 0.72 0.28 0.28 0.28 0.45 0.18
DN 80 (3") 0.17 0.68 0.68 0.27 0.27 0.27 0.43 0.17
DN 100 (4") 0.17 0.67 0.67 0.27 0.27 0.27 0.42 0.17
DN 125 (5") 0.17 0.66 0.66 0.27 0.27 0.27 0.41 0.17
DN 150 (6") 0.15 0.60 0.60 0.24 0.24 0.24 0.38 0.15
DN 200 (5") 0.17 0.68 0.68 0.27 0.27 0.27 0.42 0.17
DN 250 (10") 0.17 0.66 0.66 0.27 0.27 0.27 0.42 0.17
DN 300 (12") 0.24 0.61 0.38 0.24 0.24 0.24 0.38 0.24
DN 350 (14") 0.21 0.52 0.32 0.32 0.32 0.32 0.52 0.21
DN 400 (16") 0.17 0.68 0.42 0.42 0.42 0.42 0.42 0.17
DN 450 (18") 0.21 0.34 0.21 0.14 0.14 0.14 0.21 0.21
DN 500 (20") 0.17 0.42 0.27 0.17 0.17 0.17 0.27 0.17
DN 600 (16") 0.24 0.38 0.24 0.15 0.15 0.15 0.24 0.24

Table F-3 Flow rate at low flow cutoff = 15mm/s
Sensor size Flow rate (m3/h)
DN 25 (1") 0.027
DN 40 (1½") 0.068
DN 50 (2") 0.11
DN 65 (2½") 0.18
DN 80 (3") 0.27
DN 100 (4") 0.42
DN 125 (5") 0.66
DN 150 (6") 0.95
DN 200 (8") 1.70
DN 250 (10") 2.65
DN 300 (12") 3.82
DN 350 (14") 5.20
DN 400 (16") 6.79
DN 450 (18") 8.59
DN 500 (20") 10.60
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Sensor size Flow rate (m3/h)
DN 600 (24") 15.27
DN 700 (27½") 20.78
DN 750 (29½") 23.86
DN 800 (31") 27.14
DN 900 (35") 34.35
DN 1000 (39") 42.41
DN 1050 (41") 46.76
DN 1100 (43") 51.32
DN 1200 (47") 61.07

F.5 400-499
Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
400* All - Output A enable MLFB-dependent Yes / No
401* All Se3 Pulse A direction Forward Forward, Reverse, Forward net, 

Reverse net
402* All Se3 Amount per pulse A Sensor-related 0 to 1x109

403* All - Pulse width for pulse A 50 ms 10 ms, 25ms, 50 ms, 100 ms, 
500 ms, 5 ms, 0.5 ms

404* All - Output B enable MLFB-dependent Yes / No
405* All Se4 Pulse B function Alarm Pulse, Alarm, Call-up
406* All  Pulse B direction Reverse Forward, Reverse, Forward net, 

Reverse net
407* All Se4 Amount per pulse B Sensor-related 0 to 1x109

408* All  Pulse width for pulse B 50 ms 10 ms, 50 ms, 100 ms, 500 ms
420 All M5 Device Communication Ad‐

dress
1 1 to 247

421** All M6 Baud rate 19 200 1200, 2400, 4800, 9600, 19 
200, 38 400

422** All M7 Parity Even 1 stop Even 1 stop, Odd 1 stop, None 1 
stop, None 2 stop,

423** All - Interframe space 35 35 to 255
424** All - Response delay 5 1 to 50 ms
425 All - Reset communication driver No Yes / No

This parameter is removed from 
PDM parameter list. The func‐
tionality is implemented via PDM 
menu "Device" → "Communica‐
tion Settings" → "Transfer"

*: The parameter is accessible via PDM menu "Device" →"Pulse guide offline".
**: The parameter is accessible via the PDM menu "Device" → "Communication settings".
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F.6 500-599
Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
500 All - Latest service date PS3 production date and 

time
year-month-day T hours:mi‐
nutes:seconds

501 All - Operating hours since power-
up

0 hours

502 All - Battery operating time 0 hours
505 All - Power supply Power supply level Battery or mains power
506 All - Numbers of power-up MLFB-dependent 1 to 4 batteries
507 All - Battery power   
508 All - Battery change enable No Yes / No
509 All Se1 Battery installation date PS3 production date and 

time
year-month-day T hours:mi‐
nutes:seconds

510 All Se2 Actual battery capacity 100% 100 to 0%
511 All - Communication module type MLFB-dependent No module, RS 485, RS 232, RS 

232 always connected
512 All - Number of excitations since 

last battery reset
0  

513 All - Power status 0 Normal operation,
1: Battery alarm. Actual battery 
capacity is below battery alarm 
level (% of max capacity)
2: Too low power (enters stand 
by mode)
3: As value 1 and 2 together
4: External power gone
5: As value 1 and 4 together
6: As value 2 and 4 together
7: As value 1 and 2 and 4 togeth‐
er

514 All - Transmitter temperature Actual degree celsius  
520 All with 

FW 3.12 
and lat‐
er

- Calibration temperature Configurable Ambient temperature during 
test

521 All with 
FW 3.11 
and lat‐
er 

- Temperature offset value Measured value -100 °C to +100 °C 

522 All with 
FW 3.12 
and lat‐
er

- Temperature calibration start 0 Yes / No

540 All - Electrode impedance A Measured values 0 to 185 000 ohm
541 All - Electrode impedance B Measured values 0 to 185 000 ohm
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
542 All - Low medium impedance 

alarm
0 0 to 2.15x109

550 All - Coil current disable No Yes / No
551 All - Fixed flow mode enable No Yes / No

Value is reset to "No" in 4 hours.
552 All - Fixed flow value 0 -1x10x109 to 1x10x109

553 All - High flow alarm limit 1 000 000 000 0 to 1x109

554 All - Reverse flow alarm limit -1x109 -1x109 to 1x109

560 All - Repair checksum No Yes / No 
Value is reset to "No" when up‐
loading device parameters to pc 
after command execution

570 All - Device Product ID vendor id = 42
product id = 27

Siemens MAG 8000 product ID:
vendor id = 42
product id = 27

590 All with 
FW 3.07 
and lat‐
er

- Raw velocity Measured value  

591 All with 
FW 3.11 
and lat‐
er 

- Suppress count -  

592 All with 
FW 3.07 
and lat‐
er

- Electrode potential Measured value within ±1.2V

593 All with 
FW 3.12 
and lat‐
er

- Unfiltered electrode impe‐
dance A

Measured value  

594 All with 
FW 3.12 
and lat‐
er

- Unfiltered electrode impe‐
dance B

Measured value  
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F.7 600-799
Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
600 All - Log interval Monthly Daily, Weekly (7 days), Monthly
601 All - Delay of weekly logging from 

current day to first day logging 
at 00:00:00

0 0 to 30

602 All - - Limit for too high consump‐
tion

1 000 000 -1x109 to 1x109

603 All - Limit for too low consumption 0 -1x109 to 1x109

610* All L1 Date of latest log period 2000-01-01 T 00:00:00 year-month-day T hours:mi‐
nutes:seconds

611* All L1 Latest Log period totalized (1)   
612* All - Latest Log period totalized (2) 0  
613* All - Latest Log period fault status* No faults Active faults in log period; 

1: Insulation error
2: Coil current error
3: Amplifier overload
4: Database checksum error
5: Low power warning
6: Flow overflow warning
7: Pulse A overload warning
9: Consumption interval warning
10/L: Leakage warning
11/E: Empty pipe warning
12/C: Low impedance/ high con‐
ductivity warning
13/d: High flow limit warning
14/15/16: Not used
If none of the errors have been 
logged, the message is "No 
faults"

614* All - Latest Log period status infor‐
mation*

 Meter operation conditions in 
log period
1: Totalizer 1 or 2 changed or re‐
set
2: Tariff setting changed or reset
3: Tariff register changed or reset
4: Date - time changed
5: Alarm active in logged period 
(See alarm fault log for same pe‐
riod)
6: Fault log has been reset
7: HW lock broken
8: Power Up
If none of the information has 
been logged, the message is "No 
Faults"

615* All L2 Date of log period 2   
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
616* All L2 Log period 2 totalized (1)   
617* All - Log period 2 totalized (2)   
618* All - Log period 2 fault status  See 613
619* All - Log period 2 status informa‐

tion
 See 614

620* All L3 Date of log period 3   
621* All L3 Log period 3 totalized (1)   
622* All - Log period 3 totalized (2)   
623* All - Log period 3 fault status  See 613
624* All - Log period 3 status informa‐

tion
 See 614

625* All L4 Date of log period 4   
626* All L4 Log period 4 totalized (1)   
627* All - Log period 4 totalized (2)   
628* All - Log period 4 fault status  See 613
629* All - Log period 4 status informa‐

tion
 See 614

630* All L5 Date of log period 5   
631* All L5 Log period 5 totalized (1)   
632* All - Log period 5 totalized (2)   
633* All - Log period 5 fault status  See 613
634* All - Log period 5 status informa‐

tion
 See 614

635* All L6 Date of log period 6   
636* All L6 Log period 6 totalized (1)   
637* All - Log period 6 totalized (2)   
638* All - Log period 6 fault status  See 613
639* All - Log period 6 status informa‐

tion
 See 614

640' All L7 Date of log period 7   
641* All L7 Log period 7 totalized (1)   
642* All - Log period 7 totalized (2)   
643* All - Log period 7 fault status  See 613
644* All - Log period 7 status informa‐

tion
 See 614

645* All L8 Date of log period 8   
646* All L8 Log period 8 totalized (1)   
647* All - Log period 8 totalized (2)   
648* All - Log period 8 fault status  See 613
649* All - Log period 8 status informa‐

tion
 See 614

650* All L9 Date of log period 9   
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
651* All L9 Log period 9 totalized (1)   
652* All - Log period 9 totalized (2)   
653* All - Log period 9 fault status  See 613
654* All - Log period 9 status informa‐

tion
 See 614

655* All L10 Date of log period 10   
656* All L10 Log period 10 totalized (1)   
657* All - Log period 10 totalized (2)   
658* All - Log period 10 fault status  See 613
659* All - Log period 10 status informa‐

tion
 See 614

660 All L11 Date of log period 11   
661* All L11 Log period 11 totalized (1)   
662* All - Log period 11 totalized (2)   
663* All - Log period 11 fault status  See 613
664* All - Log period 11 status informa‐

tion
 See 614

665* All L12 Date of log period 12   
666* All L12 Log period 12 totalized (1)   
667* All  Log period 12 totalized (2)   
668* All - Log period 12 fault status  See 613
669* All - Log period 12 status informa‐

tion
 See 614

670* All L13 Date of log period 13   
671* All L13 Log period 13 totalized (1)   
672* All - - Log period 13 totalized (2)   
673* All - Log period 13 fault status  See 613
674* All - Log period 13 status informa‐

tion
 See 614

675* All L14 Date of log period 14   
676* All L14 Log period 14 totalized (1)   
677* All - Log period 14 totalized (2)   
678* All - Log period 14 fault status  See 613
679* All - Log period 14 status informa‐

tion
 See 614

680* All L15 Date of log period 15   
681* All L15 Log period 15 totalized (1)   
682* All - Log period 15 totalized (2)   
683* All - Log period 15 fault status  See 613
684* All - Log period 15 status informa‐

tion
 See 614

685* All L16 Date of log period 16   
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
686* All L16 Log period 16 totalized (1)   
687* All - Log period 16 totalized (2)   
688* All - Log period 16 fault status  See 613
689* All - Log period 16 status informa‐

tion
 See 614

690* All L17 Date of log period 17   
691* All L17 Log period 17 totalized (1)   
692* All - Log period 17 totalized (2)   
693* All - Log period 17 fault status  See 613
694* All - Log period 17 status informa‐

tion
 See 614

695 All L18 Date of log period 18   
696* All L18 Log period 18 totalized (1)   
697* All - Log period 18 totalized (2)   
698* All - Log period 18 fault status  See 613
699* All - Log period 18 status informa‐

tion
 See 614

700* All L19 Date of log period 19   
701* All L19 Log period 19 totalized (1)   
702* All - Log period 19 totalized (2)   
703* All - Log period 19 fault status  See 613
704* All - Log period 19 status informa‐

tion
 See 614

705* All L20 Date of log period 20   
706* All L20 Log period 20 totalized (1)   
707* All - Log period 20 totalized (2)   
708* All - Log period 20 fault status  See 613
709* All - Log period 20 status informa‐

tion
 See 614

710* All L21 Date of log period 21   
711* All L21 Log period 21 totalized (1)   
712* All - Log period 21 totalized (2)   
713* All - Log period 21 fault status  See 613
714* All - Log period 21 status informa‐

tion
 See 614

715* All L22 Date of log period 22   
716* All L22 Log period 22 totalized (1)   
717* All - Log period 22 totalized (2)   
718* All - Log period 22 fault status  See 613
719* All - Log period 22 status informa‐

tion
 See 614

720* All L23 Date of log period 23   
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
721* All L23 Log period 23 totalized (1)   
722* All - Log period 23 totalized (2)   
723* All - Log period 23 fault status  See 613
724* All - Log period 23 status informa‐

tion
 See 614

725* All L24 Date of log period 24   
726* All L24 Log period 24 totalized (1)   
727* All - Log period 24 totalized (2)   
728* All - Log period 24 fault status  See 613
729* All - Log period 24 status informa‐

tion
 See 614

730* All L25 Date of log period 25   
731* All L25 Log period 25 totalized (1)   
732* All - Log period 25 totalized (2)   
733* All - Log period 25 fault status  See 613
734* All - Log period 25 status informa‐

tion
 See 614

735* All L26 Date of log period 26   
736* All L26 Log period 26 totalized (1)   
737* All - Log period 26 totalized (2)   
738* All - Log period 26 fault status  See 613
739* All - Log period 26 status informa‐

tion
 See 614

*: Can be accessed via PDM menu "View" → "Log".

F.8 800-899
Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
800 All - Insulation test enable No Yes / No

Value is reset to "No" when the 
test is finished

801 All - Insulation test interval 30 0 to 65535
802 All - Insulation value   
803 All - Insulation test date 2000-01-01 T00:00 year-month- day T hours:mi‐

nutes:seconds
804 All - Insulation tests fulfilled 0  
805 All - Insulation test upper limit 2.5 mm/s  
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
810 Advanced - Leakage detection mode Off Off / fixed limit / lowest + fixed 

limit
811 Advanced - Leakage source Flow rate Flow rate / volume
812 Advanced - Start period for leakage de‐

tection
120 min = 2:00 [24:00] 0 to 1440 detection minutes (0 

to 23:50)
813 Advanced - Duration leakage detec‐

tion
0 0 to 144 (10 to 1440 minutes)

814 Advanced - Leakage value unit Flow / volume unit The unit is updated once param‐
eter 811 change is downloaded 
to the device and afterwards up‐
loaded to the pc

815 Advanced - Leakage limit 1 0 to 1x109

The unit is updated once param‐
eter 811 change is downloaded 
to device and afterwards uploa‐
ded to pc

816 Advanced - - Leakage excitation fre‐
quency

1.5625 Hz 1/60 Hz, 1/30 Hz, 1/15 Hz, 
1/5 Hz, 1.5625 Hz, 3.125 Hz, 
6.25 Hz

817 Advanced - Leakage status No faults Leakage status:
1: Finished successfully
2: Leakage detection running
3: Leakage detection failed (Sys‐
temStatus have fatal error)
4: Leakage detection failed 
(Empty-pipe detection disabled)
5: Leakage detection failed (Coil 
current off)
6: Leakage detection failed (In‐
sulation test was active during 
detection)
7: Leakage detection stopped be‐
cause leakage parameter was 
changed.
If none of the above-mentioned 
leakage status messages is pend‐
ing, the message is "No faults"

818 Advanced - Periods with possible leak‐
age

  

819 Advanced - Leakage periods before 
alarm

30 0 to 255

820 Advanced - Reset leakage period infor‐
mation

No Yes / No 
Value is reset to "No" when up‐
loading device parameters to pc 
after command execution

821 Advanced St1 Latest leakage period flow‐
rate

0  

822 Advanced St1 Latest leakage period vol‐
ume

0  
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
823 Advanced - Lowest measured leakage 

value
1 000 000 000 The unit is updated once param‐

eter 811 change is downloaded 
to device and afterwards uploa‐
ded to pc

824 Advanced - Date of lowest leakage val‐
ue

2000-01-01 T00:00 year-month-day T hours:mi‐
nutes:seconds

825 Advanced - Highest measured leakage 
value

-1x109 The unit is updated once param‐
eter 811 change is downloaded 
to device and afterwards uploa‐
ded to pc

826 Advanced - Date of highest leakage 
value

2000-01-01 T00:00 year-month-day T hours:mi‐
nutes:seconds

830 Advanced R8 Next settling date PS3 production date and 
time

year-month-day T 23:59:59

831 Advanced R9 Latest settling date PS3 production date and 
time

year-month-day T 23:59:59

832 Advanced R9 Latest totalizer 1 value 0  
833 Advanced R10 Previous settling date PS3 production date and 

time
year-month-day T hours:mi‐
nutes:seconds

834 Advanced R10 Previous totalizer 1 value 0  
840 Advanced  Tariff control mode Off Off / time / range / combination
841 Advanced R7 Date of tariff reset PS3 production date and 

time
year-month-day T hours:mi‐
nutes:seconds

842 Advanced - Reset tariff values No Yes / No 
Value is reset to "No" when up‐
loading device parameters to pc 
after command execution

843 Advanced R1 Tariff1 volume 1 0  
844 Advanced R1 Tariff1 period time end 360 min = 6:00 [24:00] 0 to 1439 minutes (23:59)
845 Advanced R1 Tariff1 upper limit range 15% 0 to 100% Qn (Q3)
846 Advanced R2 Tariff2 volume 2 0  
847 Advanced R2 Tariff2 period time end 540 min = 9:00 [24:00] 0 to 1439 minutes (23:59)
848 Advanced R2 Tariff2 upper limit range 30% 0 to 100% Qn (Q3)
849 Advanced R3 Tariff3 volume 3 0  
850 Advanced R3 Tarif3 period time end 720 min = 12:00 [24:00] 0 to 1439 minutes (23:59)
851 Advanced R3 Tariff3 upper limit range 45% 0 to 100% Qn (Q3)
852 Advanced R4 Tariff4 volume 4 0  
853 Advanced R4 Tariff4 period time end 1080min=18:00 [24:00] 0 to 1439 minutes (23:59)
854 Advanced R4 Tariff4 upper limit range 60% 0 to 100% Qn (Q3)
855 Advanced R5 Tariff5 volume 5 0  
856 Advanced R5 Tariff5 period time end 1260 min = 21:00 [24:00] 0 to 1439 minutes (23:59)
857 Advanced R5 Tariff5 upper limit range 80% 0 to 100% Qn (Q3)
858 Advanced R6 Tariff6 volume 6 0  
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
860 Advanced - Reset date of statistic inf. PS3 production date and 

time 
year- month-day T hours:mi‐
nutes:seconds

861 Advanced - Reset statistic information No Yes / No 
Value is reset to "No" when up‐
loading device parameters to pc 
after command execution

862 Advanced St2 Lowest flowrate 0  
863 Advanced St2 Date of lowest flowrate PS3 production date and 

time
year-month-day T hours:mi‐
nutes:seconds

864 Advanced St3 Highest flowrate 0  
865 Advanced St3 Date of highest flowrate PS3 production date and 

time
year-month-day T hours:mi‐
nutes:seconds

866 Advanced St5 Lowest day consumption 0  
867 Advanced - Date of lowest day con‐

sumption
PS3 production date and 
time

year-month-day T hours:mi‐
nutes:seconds

868 Advanced St6 Highest day consumption 0  
869 Advanced - Date of highest day con‐

sumption
PS3 production date and 
time

year-month-day T hours:mi‐
nutes:seconds

870 Advanced St4 Day 1 (yesterday) of last 
week consumption

0  

871 Advanced - Day 2 of last week con‐
sumption 

0  

872 Advanced - Day 3 of last week con‐
sumption

0  

873 Advanced - Day 4 of last week con‐
sumption

0  

874 Advanced - Day 5 of last week con‐
sumption

0  

875 Advanced - Day 6 of last week con‐
sumption

0  

876 Advanced - Day 7 (7 days ago) of last 
week consumption

0  

877 Advanced St7 Latest week consumption 0  
878 Advanced St8 Actual month consump‐

tion
0  

879 Advanced St9 Latest month consump‐
tion

0  

880 Advanced - Reset date of consump‐
tion profile

PS3 production date and 
time

year-month-day T hours:mi‐
nutes:seconds

881 Advanced - Reset consumption profile No Yes / No 
Value is reset to "No" when up‐
loading device parameters to pc 
after command execution

882 Advanced - Total time in CP range 1 0  
883 Advanced - Upper limit in CP range 1 15% 0 to 100% Qn (Q3)

Parameter lists
F.8 800-899
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Param‐
eter ID

Meter
version

Display
view

Parameter/data type Factory settings Data range

    Fixed parameter or meter data that are not changeable
884 Advanced - Total time in CP range 2 0  
885 Advanced - Upper limit in CP range 2 30% 0 to 100% Qn (Q3)
886 Advanced - Total time in CP range 3 0  
887 Advanced - Upper limit in CP range 3 45% 0 to 100% Qn (Q3)
888 Advanced - Total time in CP range 4 0  
889 Advanced - Upper limit in CP range 4 60% 0 to 100% Qn (Q3)
890 Advanced - Total time in CP range 5 0  
891 Advanced - Upper limit in CP range 5 80% 0 to 100% Qn (Q3)
892 Advanced - Total time in CP range 6 0  

Parameter lists
F.8 800-899
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Sizing sensor G
G.1 Sizing table DN 25 to 1200 (1" to 48")

The following table shows the relationship between flow velocity (V), flow quantity (Q) and 
sensor dimension (DN).

Figure G-1 Sizing table   
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Guidelines for selection of sensor
Normally the sensor is selected so that V lies within the measuring range 1 to 2 m/s (3 to 7 ft/sec.).
• Min. measuring range: 0 to 0.25 m/s (0 to 0.8 ft/sec.)
• Max. measuring range: 0 to 10 m/s (0 to 33 ft/sec.)

Flow velocity calculation formula
• Metric measures:

V = 1273.24 x Q / Di2 (V: [m/s]; Q: [L/s]; Di: [mm])
or
V = 353.68 x Q / Di2 (V: [m/s]; Q: [m3/h]; Di: [mm])

• Imperial measures:
V = Q x 0.408 / (Pipe I.D.)2 (V: [ft/s]; Q: [GPM]; Pipe I.D.: [inch])
or
V = Q x 283.67 / (Pipe I.D.)2 (V: [ft/s]; Q: [MGD]; Pipe I.D.: [inch])

Sizing sensor
G.1 Sizing table DN 25 to 1200 (1" to 48")
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Features H
Feature MAG 8000 basic MAG 8000 advanced
Measurement frequency
(battery power)

Max. 1/15 Hz Max. 6.25 Hz

Totalizer 3 3
Pulse output 2, max. 50 Hz 2, max. 100 Hz
Communication Add-on Add-on
IrDA Yes Yes
Time and date Yes Yes
Data protection Yes Yes
Data logger Yes Yes
Application identifier Yes Yes
Alarm handling Yes Yes
Meter status Yes Yes
Diagnostics Yes Yes
Battery power management Yes Yes
Insulation test - Yes
Leakage detection - Yes
Meter utilization - Yes
Statistics - Yes
Tariff - Yes
Settle date (Revenue) - Yes

Features
Application identification (parameters 1 and 2)
Tag number (visible on display if numbers are selected) and meter location, up to 15 characters 
per information.
Time and date (parameter 100)
Real time clock and date (max. 15 minutes drift per year)
Totalizer (parameters 101, 102 and 103)
• 3 totalizers: Forward, reverse, bidirectional netflow calculation and freely selectable start 

value.

Note
CT version
It is not allowed to reset the totalizer for the CT version.
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Measurement (parameters 300 and 334)
• Freely selectable volume and flow unit, where m3 and m3/h is default in display. All other units 

are displayed with a display label.
• Excitation frequency in battery operation (manually selected):

– Basic, max. selectable excitation frequency of 1/15 Hz
– Advanced, max. selectable excitation frequency of 6.25 Hz and sensor related
– MAG 8000 default excitation frequency with 2 D-cell battery pack is selected for typically 

6 years of operation for MAG 8000 Standard (7ME6810) and MAG 8000 CT (7ME6820).

Size Default excitation frequency
MAG 8000 Standard (7ME6810)

MAG 8000 CT (7ME6820)
DN 25 to DN 15
(1" to 6")

1/15 Hz

DN 200 to DN 600
(8" to 24")

1/30 Hz

DN 700 to DN 1200
(28" to 48")

1/60 Hz

• Excitation frequency with mains power follows maximum sensor excitation frequency
• Filter constant as numbers of excitations
• Low flow cut-off: 15mm/s factory default value1)

• Empty pipe detection (active symbol on display when active)
• Filter selection for mains power frequency (50/60 Hz)
• Correction factor for change of flow direction or to adjust flow measurement
1) Siemens warrants the measurement accuracy down to a flow velocity of 15mm/s. For a flow 
velocity below 15mm/s, we don't warrant the measurement accuracy.
Data logger (Parameters 600 to 739)
• Logging of 26 records: selectable as daily, weekly or monthly logging
• Each logging includes:

– Consumption on totalizer 1
– Consumption on totalizer 2
– Alarm in current period (13 alarms)
– Meter status (8 values)
– Alarm on high or low consumption for selected logging period
– Totalizer 1 values for all 26 periods can be read on the display

Features
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Alarm (parameters 200 to 274)
• Active alarm is indicated on the display
• Monitoring of all alarms with statistic recording on each alarm

– Total hours an alarm has been active
– Numbers of time the alarm has been activated
– First time an alarm appears
– Last time the alarm disappears

• Fatal faults interrupt the measurement, if active
– Signal insulation – Flow signal immunity is influenced (Advanced version only)
– Coil current – Fault in driving magnetic sensor field
– Amplifier – Fault in signal circuit
– Check sum – Fault in calculation or handling of data

• Warning faults
– Low Power – Alarm for customer-selectable battery level or power drop-out
– Flow overflow – Flow in sensor exceeds Qmax (125 % Qn (Q3, Q4))
– Pulse overflow on output A and B – Selected pulse volume is too small compared to actual 

flow rate and max. output pulse rate
– Consumption – Saved data logger consumption exceeds customer selected limit on high 

or low consumption
– Leakage – Leakage detected based on customer settings (Advanced version only)
– Empty pipe – No water in the pipe/sensor
– Low impedance – Measured electrode impedance below customer low impedance level
– Flow limit – Actual flow exceeds selected high flow limited

Meter status (parameter 120)
Monitoring of important revenue parameters and data
• Changing totalizers 1 and 2
• Changing tariff totalizer
• Changing tariff settings
• Changing date and time
• Alarm has been active (see alarm log for details)
• Fault log has been reset
• Hardware key has been broken
• Meter has been repowered

Features

SITRANS FM MAG 8000 Battery-operated water meter
Operating Instructions, 08/2022, A5E03071515-AL 171



Data protection
• All data stored in an EEPROM. Totalizers 1 and 2 are backed up every 10 min., statistic every 

hour and power consumption and temperature measurement every 4 hours.
• Password protection of all parameters and hardware protection of calibration and revenue 

parameters.
Battery power management
• Optimal battery information on remaining capacity.
• Calculated capacity includes all consuming elements and available battery capacity is 

adjusted related to change in ambient temperature.
Diagnostic
• Continuous self test including

– Coil current to drive the magnetic field
– Signal input circuit
– Data calculation, handling and storing

• Features
– Alarm statistics and logging for fault analyzing
– Electrode impedance to check actual media contact
– Flow simulation to check pulse and communication signal chain for correct scaling
– Number of sensor measurements (excitations)
– Transmitter temperature (battery capacity calculation)
– Low impedance alarm for change in media
– Flow alarm when defined high flow exceeds
– Insulation test
– Verification mode for fast measure performance check

• Advanced version includes
– Leakage detection
– Consumption profile
– Flow statistic

Insulation test
Test of signal immunity against disturbances and poor installations. Test interval is selectable 
and measurement is interrupted during the test period of 4 min. The last flow value is used for 
totalization.
Leakage detection (Advanced version only)
Monitoring the lowest flow or volume during selected time window within 24 hours. Leakage 
is detected over a selectable period during which monitored values exceed the possible leakage 
level. Min. and max. values are stored with date registration. Last store value visible on the 
display.

Features
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Consumption profile (Advanced version only)
6 registers for monitoring total time the meter has operated in different flow intervals. 
Registered intervals are freely selectable as % of Qn (Q3).
Tariff (Advanced version only)
6 tariff registers count the volume delivered within the selected tariff windows, based on time 
of day, flow rates, or a combination.
Tariff can also be used for consumption profile where consumption is related to different time 
intervals or flow rates.
Tariff values visible on the display.
Settling date (Advanced version only)
At midnight (23:59:59) on a predefined date the totalizer 1 index value is stored. Old values are 
stored to show the latest two totalized 1 index values. Settling values are visible on the display.
Statistic (Advanced version only)
The statistic feature delivers water consumption information to inspect the consumption limits 
of the installation. The real values are first available after the period is finished. A reset function 
clears the values and new values are ready after next period. Until the new measured values are 
available, minimum values are set to maximum value and vice versa, the rest is set to zero. 
• Min. flow rate with time and date registration
• Max. flow rate with time and date registration
• Min. daily consumption with date registration
• Max. daily consumption with date registration
• Latest 7 days' total and daily consumption
• Actual month's consumption
• Latest month's consumption

Features
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